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1 Before installation 
This section answers questions that might arise before the product installation. 
 

1.1 About using the product in the trial mode 
Before buying an Acronis Backup & Recovery 11.5 license, you may want to try the software. This can 
be done without a license key. 

To install the product in the trial mode, run the setup program locally or use the remote installation 
(p. 47) functionality. Unattended installation and other ways of installation (p. 18) are not supported. 

Limitations of the trial mode 
When installed in the trial mode, Acronis Backup & Recovery 11.5 has the following limitation: 

 The Universal Restore functionality is disabled. 

Additional limitations for bootable media: 

 The disk management functionality is not available. You can try the user interface, but there is no 
option to commit the changes. 

 The recovery functionality is available, but the backup functionality is not. To try the backup 
functionality, install the software in the operating system. 

Upgrading to the full mode 
After the trial period expires, the product GUI displays a notification requesting you to specify or 
obtain a license key. 

To specify a license key, click Help > Change License. Specifying the key by running the setup 
program is not possible. 

If you have activated a trial or purchased subscription for the online backup service, online backup 
will be available until the subscription period expires, regardless of whether you specify a license key. 
 

1.2 Types of licenses (stand-alone and advanced 
editions) 

Acronis Backup & Recovery 11.5 licensing is based on the number of machines backed up by the 
product.  

Stand-alone editions 
These are the following editions: 

 Acronis Backup & Recovery 11.5 Server for Windows 
 Acronis Backup & Recovery 11.5 Server for Linux 
 Acronis Backup & Recovery 11.5 Workstation 

The stand-alone editions are designed for backing up the data of a single machine. With any of the 
above licenses, you can install all the product components on the same machine only. You will be 
asked for the license key of any of the above editions during the product installation.  
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Advanced editions (editions with centralized management) 
These are the following editions: 

 Acronis Backup & Recovery 11.5 Advanced Server 
 Acronis Backup & Recovery 11.5 Virtual Edition 
 Acronis Backup & Recovery 11.5 Advanced Server SBS Edition 
 Acronis Backup & Recovery 11.5 Advanced Workstation 

These editions are designed for backing up multiple machines. In addition to components that need 
to be installed on a backed-up machine, these editions include a management server that enables 
centralized management, and storage nodes for storing backed up data on them. Unlike stand-alone 
editions, advanced editions allow remote connection to a backed-up machine. 

As with stand-alone editions, a separate license is required for every machine you want to back up. 
During installation of a licensed component (agent), you can either specify a license server or enter a 
license key manually. Installation of other components is not licensed. For example, you can install as 
many storage nodes as you wish - up to 50. 

Components of stand-alone editions do not interact with the components of advanced editions. 
 

1.3 Acronis Backup & Recovery 11.5 components 
This section contains a full list of Acronis Backup & Recovery 11.5 components with a brief 
description of their functionality. 

Acronis Backup & Recovery 11.5 includes the following main types of components. 

Components for a managed machine (agents) 
These are applications that perform data backup, recovery and other operations on the machines 
managed with Acronis Backup & Recovery 11.5. Agents require a license to perform operations on 
each managed machine. Agents have multiple features, or add-ons, that enable additional 
functionality and so might require additional licenses. 

Components for centralized management 
These components, delivered with the advanced editions, provide centralized management 
capability. Usage of these components is not licensed. 

Console 
The console provides Graphical User Interface and remote connection to the agents and other 
Acronis Backup & Recovery 11.5 components. Usage of the console is not licensed. 

Bootable media builder 
With bootable media builder, you can create bootable media in order to use the agents and other 
rescue utilities in a rescue environment.  

Bootable Media Builder does not require a license if installed together with an agent. All add-ons to 
the agent, if installed, will be available in a rescue environment. To use a media builder on a machine 
without an agent, you need to enter the license key or have at least one license on the license server. 
The license may be either available or assigned. 
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1.3.1 Agent for Windows 
This agent enables disk-level and file-level data protection under Windows. 

Disk backup 
Disk-level data protection is based on backing up either a disk or a volume file system as a whole, 
along with all the information necessary for the operating system to boot; or all the disk sectors using 
the sector-by-sector approach (raw mode). A backup that contains a copy of a disk or a volume in a 
packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover 
disks or volumes as a whole from such backup, as well as individual folders or files. 

File backup 
File-level data protection is based on backing up files and folders residing on the machine where the 
agent is installed or on a network share. Files can be recovered to their original location or to another 
place. It is possible to recover all files and folders that were backed up or select which of them to 
recover. 

Other operations 
Conversion to a virtual machine 

Agent for Windows performs the conversion by recovering a disk backup to a new virtual machine of 
any of the following types: VMware Workstation, Microsoft Virtual PC, Citrix XenServer Open Virtual 
Appliance (OVA) or Red Hat Kernel-based Virtual Machine (KVM). Files of the fully configured and 
operational machine will be placed in the folder you select. You can start the machine using the 
respective virtualization software or prepare the machine files for further usage. 

Disk management 

Agent for Windows includes Acronis Disk Director Lite - a handy disk management utility. Disk 
management operations, such as cloning disks; converting disks; creating, formatting and deleting 
volumes; changing a disk partitioning style between MBR and GPT or changing a disk label, can be 
performed either in the operating system or using bootable media. 
 

1.3.1.1 Universal Restore 
The Universal Restore add-on enables you to use the restore to dissimilar hardware functionality on 
the machine where the agent is installed and create bootable media with this functionality. Universal 
Restore handles differences in devices that are critical for the operating system start-up, such as 
storage controllers, motherboard or chipset. 
 

1.3.1.2 Deduplication 
This add-on enables the agent to back up data to deduplicating vaults managed by Acronis Backup & 
Recovery 11.5 Storage Node. 
 

1.3.2 Agent for Linux 
This agent enables disk-level and file-level data protection under Linux. 
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Disk backup 
Disk-level data protection is based on backing up either a disk or a volume file system as a whole, 
along with all information necessary for the operating system to boot; or all the disk sectors using the 
sector-by-sector approach (raw mode.) A backup that contains a copy of a disk or a volume in a 
packaged form is called a disk (volume) backup or a disk (volume) image. It is possible to recover 
disks or volumes as a whole from such backup, as well as individual folders or files.  

File backup 
File-level data protection is based on backing up files and directories residing on the machine where 
the agent is installed or on a network share accessed using the smb or nfs protocol. Files can be 
recovered to their original location or to another place. It is possible to recover all files and 
directories that were backed up or select which of them to recover. 

Conversion to a virtual machine 
Agent for Linux performs the conversion by recovering a disk backup to a new virtual machine of any 
of the following types: VMware Workstation, Microsoft Virtual PC, Citrix XenServer Open Virtual 
Appliance (OVA) or Red Hat Kernel-based Virtual Machine (KVM). Files of the fully configured and 
operational machine will be placed in the directory you select. You can start the machine using the 
respective virtualization software or prepare the machine files for further usage. 
 

1.3.2.1 Universal Restore 
The Universal Restore add-on enables you to use the restore to dissimilar hardware functionality on 
the machine where the agent is installed and create bootable media with this functionality. Universal 
Restore handles differences in devices that are critical for the operating system start-up, such as 
storage controllers, motherboard or chipset. 
 

1.3.2.2 Deduplication 
This add-on enables the agent to back up data to deduplicating vaults managed by Acronis Backup & 
Recovery 11.5 Storage Node. 
 

1.3.3 Agent for VMware vSphere ESX(i) 
Acronis Backup & Recovery 11.5 Agent for VMware vSphere ESX(i) enables backup and recovery of 
ESX(i) virtual machines without installing agents into the guest systems. This backup method is 
known as agent-less backup or backup at a hypervisor level. 

The agent is delivered in two versions: 

 Agent for VMware vSphere ESX(i) (Virtual Appliance) can be imported or deployed to a VMware 
ESX(i) host. 

 For off-loaded backup, Agent for VMware vSphere ESX(i) (Windows) can be installed on a 
machine running Windows. 

Acronis Backup & Recovery 11.5 Agent for VMware vSphere ESX(i) is referred to as Agent for ESX(i) 
later in this document. 
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1.3.4 Agent for Hyper-V 
Acronis Backup & Recovery 11.5 Agent for Hyper-V protects virtual machines residing on a Hyper-V 
virtualization server. The agent allows for backing up virtual machines from the host without having 
to install agents on each virtual machine. 

Agent for Hyper-V can be installed in the following operating systems: 

Windows Server 2008 (x64) with Hyper-V 
Windows Server 2008 R2 with Hyper-V 
Microsoft Hyper-V Server 2008/2008 R2 
Windows Server 2012/2012 R2 with Hyper-V 
Microsoft Hyper-V Server 2012/2012 R2 

Agent for Hyper-V cannot be installed in Windows 8/8.1, even though this operating system includes 
the Hyper-V feature. 
 

1.3.5 Agent for Microsoft Exchange Server 
Acronis Backup & Recovery 11.5 Agent for Microsoft Exchange Server enables you to back up and 
recover Microsoft Exchange databases or individual mailboxes. The agent uses Microsoft VSS to 
ensure the consistency of the backed-up databases. Recovery of the smaller data items (e-mails, 
calendar events or notes) is available from both database and mailbox backups. 

Acronis Backup & Recovery 11.5 Agent for Microsoft Exchange Server is referred to as Agent for 
Exchange later in this document. 
 

1.3.5.1 Deduplication for Microsoft Exchange Server 
This add-on enables Agent for Exchange to use the express full backup method for backing up 
Exchange databases to deduplicating vaults managed by Acronis Backup & Recovery 11.5 Storage 
Node. The add-on is purchased separately. You do not need to purchase and install this add-on if 
Agent for Windows and its deduplication add-on are already installed on your Exchange server. 
 

1.3.6 Agent for Microsoft SQL Server (single-pass) 
Acronis Backup & Recovery 11.5 Agent for Microsoft SQL Server (single-pass) enables you to create 
single-pass disk and application backups and to recover Microsoft SQL databases from them. The 
databases can be recovered directly to a running SQL Server instance or extracted to a folder on a file 
system.  

The agent uses Microsoft VSS to ensure the consistency of the backed-up databases. After a 
successful backup, the agent can truncate the SQL Server transaction log. 

The agent is installed as an add-on to Agent for Windows (p. 6).  

Acronis Backup & Recovery 11.5 Agent for Microsoft SQL Server (single-pass) is also referred to as 
Agent for SQL (single-pass) in this document. 
 



9 Copyright © Acronis International GmbH, 2002-2013. 

 

 

1.3.7 Agent for Microsoft Active Directory (single-pass) 
Acronis Backup & Recovery 11.5 Agent for Microsoft Active Directory (single-pass) enables you to 
create single-pass disk and application backups and to extract Microsoft Active Directory data from 
them to a folder on a file system.  

The agent uses Microsoft VSS to ensure the consistency of the backed-up data. 

The agent is installed as an add-on to Agent for Windows (p. 6).  

Acronis Backup & Recovery 11.5 Agent for Microsoft Active Directory (single-pass) is also referred to 
as Agent for Active Directory (single-pass) in this document. 
 

1.3.8 Components for centralized management 
This section lists the components included in the Acronis Backup & Recovery 11.5 editions that 
provide the centralized management capability. Besides these components, Acronis Backup & 
Recovery 11.5 Agents have to be installed on all machines that need data protection. 
 

1.3.8.1 Management Server 
Acronis Backup & Recovery 11.5 Management Server is the central server that drives data protection 
within the enterprise network. The management server provides the administrator with: 

 a single entry point to the Acronis Backup & Recovery 11.5 infrastructure 
 an easy way to protect data on numerous machines using centralized backup plans and grouping 
 integration with VMware vCenter to discover virtual machines for protection 
 enterprise-wide monitoring and reporting functionality 
 built-in license management 
 the ability to create centralized vaults for storing enterprise backup archives 
 the ability to manage storage nodes 
 the centralized catalog of all data stored on the storage nodes. 

If there are multiple management servers on the network, they operate independently, manage 
different machines and use different centralized vaults for storing archives. 
 

1.3.8.2 Storage Node 
Acronis Backup & Recovery 11.5 Storage Node is a server designed to optimize the usage of various 
resources (such as the corporate storage capacity, the network bandwidth, or the managed 
machines' CPU load) which are required to protect the enterprise data. This goal is achieved by 
organizing and managing the locations that serve as dedicated storages of the enterprise backup 
archives (managed vaults). 

The most important function of a storage node is deduplication of backups stored in its vaults. This 
means that identical data will be backed up to this vault only once. This minimizes the network usage 
during backup and storage space taken by the archives. 

The storage nodes enable creating highly scalable and flexible, in terms of the hardware support, 
storage infrastructure. Up to 50 storage nodes can be set up, each being able to manage up to 20 
vaults.  
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The administrator controls the storage nodes centrally from the Acronis Backup & Recovery 11.5 
Management Server (p. 9). Direct console connection to a storage node is not possible. 
 

1.3.8.3 Components for Remote Installation 
These are Acronis component installation packages used by the management console (p. 10) for 
installation on remote machines. 

Components for Remote Installation need to be installed on the machine with the console or with 
the management server (p. 9). During installation, the setup program saves the components in the 
default location and saves this location path in the registry. As a result, the components are readily 
available in the Remote Installation Wizard (p. 47) as "registered components". 
 

1.3.8.4 PXE Server 
Acronis PXE Server allows for booting machines into Acronis bootable components through the 
network. 

The network booting: 

 Eliminates the need to have a technician onsite to install the bootable media into the system that 
has to be booted  

 During group operations, reduces the time required for booting multiple machines as compared 
to using physical bootable media. 

 

1.3.8.5 License Server 
The server enables you to manage licenses of Acronis products and install the components that 
require licenses. 

You can install a license server as a separate component (p. 40) or use the one integrated into the 
management server. The functionality of the license server is similar for both types of installation. 
 

1.3.8.6 Acronis Wake-on-LAN Proxy 
Acronis Wake-on-LAN Proxy enables Acronis Backup & Recovery 11.5 Management Server to wake 
up for backup machines located in another subnet. Acronis Wake-on-LAN Proxy installs on any server 
in the subnet where the machines to be backed up are located. 
 

1.3.9 Management Console 
Acronis Backup & Recovery 11.5 Management Console is an administrative tool for remote or local 
access to Acronis Backup & Recovery 11.5 agents and, in the product editions that include the 
centralized management capability, to the Acronis Backup & Recovery 11.5 Management Server. 

The console has two distributions: for installation on Windows and installation on Linux. While both 
distributions enable connection to any Acronis Backup & Recovery 11.5 agent and Acronis Backup & 
Recovery 11.5 Management Server, we recommend that you use the console for Windows if you 
have a choice between the two. The console that installs on Linux has limited functionality: 

 Remote installation of Acronis Backup & Recovery 11.5 components is not available. 
 The Active Directory-related features, such as browsing the AD, are not available. 
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1.3.10 Bootable Media Builder 
Acronis Bootable Media Builder is a dedicated tool for creating bootable media. There are two media 
builder distributions: for installation in Windows and installation in Linux.  

The media builder that installs on Windows can create bootable media based on either Windows 
Preinstallation Environment, or Linux kernel. The media builder that installs on Linux creates 
bootable media based on Linux kernel. 

The Universal Restore (p. 6) add-on enables you to create bootable media with the restore to 
dissimilar hardware functionality. Universal Restore handles differences in devices that are critical for 
the operating system start-up, such as storage controllers, motherboard or chipset. 

The Deduplication (p. 6) add-on enables you to create bootable media with the back up to a 
deduplicating vault functionality. This add-on can be installed to either of the media builder 
distributions. 
 

1.4 Licensing of advanced editions 
Acronis License Server 
Licenses of advanced editions are managed by Acronis License Server. You can install a license server 
as a separate component (p. 40) or use the one integrated into the management server. The 
functionality of the license server is similar for both types of installation.  

Acronis License Server can import multiple license keys from .txt or .eml files, saving you from the 
time-consuming procedure of typing in numbers. 

Specifying licenses during installation 
During installation of a licensed component (agent), you can either specify the license server or enter 
a license key manually. When you register the machine on the management server, the manually 
entered key will be imported to the server and will be seen in the list of licenses. 

Installation of an agent is possible without specifying a license or a license server in the following 
cases: 

 When installing the software in the trial mode (p. 4). 
 When installing the software for online backup only. Such backup does not require a license, but 

requires a subscription for the Acronis Backup & Recovery Online service. 
 When installing Agent for VMware vSphere ESX(i) (p. 7) (both versions). The licenses will be 

consumed later, when a backup of the specified virtual machines starts. One Virtual Edition 
license will be required for each host where a virtual machine is selected for backup. 

Checking licenses 
An Acronis agent connects to Acronis License Server every time the agent service starts and then 
every 1–5 days, as specified by the agent configuration parameters. If the agent is unable to connect 
to the license server, it initiates an alert. The agent keeps working without the license server for 1–60 
days (as specified by the configuration parameters). After that, the agent stops doing backups 
(except for online backups) until a successful license check is completed. 
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If the agent connects to the license server but does not find the acquired license, it tries to acquire 
another license. If no license is available, the agent stops doing backups (except for online backups) 
until a license is successfully acquired. 

By default, the agent tries to connect to the license server every day and keeps working without a 
license server for 30 days. 
 

1.4.1 How many licenses do I need? 
Assume that your company network includes a server and five workstations running Windows. All 
the machines are backed up by the administrator who prefers setting up and monitoring backups 
from a single place. Therefore, you consider licenses for advanced editions. A license cost depends on 
the operating system the software is installed in. 

To protect all the machines, you need: 

 Five licenses for Acronis Backup & Recovery 11.5 Advanced Workstation 
 One license for Acronis Backup & Recovery 11.5 Advanced Server or Advanced Server SBS 

Edition, depending on the operating system your server is running. 
 

1.4.2 Licensing for virtual machines 
Acronis offers a special licensing policy for virtual machines. 

 An Acronis Backup & Recovery 11.5 Advanced Server license enables the backing up of a physical 
host and four virtual machines. 

 An Acronis Backup & Recovery 11.5 Virtual Edition license enables backing up a physical host and 
an unlimited number of hosted virtual machines. You can install the product into the guest 
systems, back them up from the host, or combine both methods. 
For a VMware vSphere or Microsoft Hyper-V cluster, you need as many licenses as there are 
nodes in the cluster. 

The following table enables you to define which Virtual Edition license is required for your 
virtualization platform. 

License name Virtualization platform 

Acronis Backup & Recovery 11.5 Virtual Edition for 
VMware vSphere 

Any supported platform developed by VMware (i.e. 
ESX, ESXi, VMware Workstation, VMware ACE)* 

Acronis Backup & Recovery 11.5 Virtual Edition for 
Hyper-V 

Any supported platform developed by Microsoft (i.e. 
Hyper-V, Windows Virtual PC)* 

Acronis Backup & Recovery 11.5 Virtual Edition for 
RHEV 

Red Hat Enterprise Virtualization 

Kernel-based Virtual Machines (KVM) 

Acronis Backup & Recovery 11.5 Virtual Edition for 
Citrix XenServer 

Citrix XenServer 

Acronis Backup & Recovery 11.5 Virtual Edition for 
Parallels 

Parallels Workstation 

Parallels Server Bare Metal 

Acronis Backup & Recovery 11.5 Virtual Edition for 
Oracle VM Server 

Oracle VM Server, Oracle VM VirtualBox 
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Acronis Backup & Recovery 11.5 Virtual Edition 
Multi-hypervisor 

All of the above 

*For the complete list of supported virtualization platforms, refer to "Supported virtualization platforms" in the 
"Backing up virtual machines" document. 
 

1.5 Supported operating systems 
Components for a managed machine 
Important: See "Support for Windows 8 and Windows Server 2012" for details and limitations of this 
support. 

Acronis Backup & Recovery 11.5 Agent for Windows 
Acronis Backup & Recovery 11.5 Advanced Server 
Acronis Backup & Recovery 11.5 Virtual Edition 

Windows XP Professional SP2+ (x86, x64) 
Windows 2000 SP4 – all editions except for the Datacenter edition 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Vista – all editions except for Vista Home Basic and Vista Home Premium (x86, x64) 
Windows Server 2008 – Standard, Enterprise, Datacenter, and Web editions (x86, x64) 
Windows Small Business Server 2008 
Windows 7 – all editions except for the Starter and Home editions (x86, x64) 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, Foundation, and Web editions 
Windows MultiPoint Server 2010/2011 
Windows Small Business Server 2011 – all editions 
Windows 8/8.1 – all editions except for the Windows RT editions (x86, x64) 
Windows Server 2012/2012 R2 – all editions 
Windows Storage Server 2003/2008/2008 R2/2012 

Acronis Backup & Recovery 11.5 Advanced Server SBS Edition 
Windows Small Business Server 2003/2003 R2 
Windows Small Business Server 2008 
Windows Small Business Server 2011 – all editions 
Windows Server 2012 – Essentials and Foundation editions 
Windows Server 2012 R2 – Essentials edition 

Acronis Backup & Recovery 11.5 Server for Windows 
Windows XP Professional SP2+ (x86, x64) 
Windows 2000 SP4 – all editions except for the Datacenter edition 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Vista – all editions (x86, x64) 
Windows Server 2008 – Standard, Enterprise, Datacenter, and Web editions (x86, x64) 
Windows Small Business Server 2008 
Windows 7 – all editions (x86, x64) 
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Windows Server 2008 R2 – Standard, Enterprise, Datacenter, Foundation, and Web editions 
Windows MultiPoint Server 2010/2011 
Windows Small Business Server 2011 – all editions 
Windows 8/8.1 – all editions except for the Windows RT editions (x86, x64) 
Windows Server 2012/2012 R2 – all editions 
Windows Storage Server 2003/2008/2008 R2/2012 
Remote connection to the agent is not possible. 

Acronis Backup & Recovery 11.5 Agent for Microsoft Exchange Server 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64) 
Windows Small Business Server 2008 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions 
Windows Small Business Server 2011 – all editions 
Windows Server 2012/2012 R2 – Standard and Datacenter editions 

Acronis Backup & Recovery 11.5 Agent for Microsoft SQL Server (single-pass) 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64) 
Windows Small Business Server 2008 
Windows 7 – all editions except for the Starter and Home editions (x86, x64) 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions 
Windows MultiPoint Server 2010/2011 
Windows Small Business Server 2011 – all editions 
Windows 8/8.1 – all editions except for the Windows RT editions (x86, x64) 
Windows Server 2012/2012 R2 – all editions 
Windows Storage Server 2003/2008/2008 R2/2012 

Acronis Backup & Recovery 11.5 Agent for Microsoft Active Directory (single-pass) 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64) 
Windows Small Business Server 2008 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions 
Windows Small Business Server 2011 – all editions 
Windows Server 2012/2012 R2 – all editions 

Acronis Backup & Recovery 11.5 Agent for Linux 
Acronis Backup & Recovery 11.5 Advanced Server  
Acronis Backup & Recovery 11.5 Virtual Edition 
Acronis Backup & Recovery 11.5 Server for Linux 

Linux with kernel from 2.4.20 to 3.9 and glibc 2.3.2 or later 
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Various x86 and x86_64 Linux distributions, including: 
Red Hat Enterprise Linux 4.x, 5.x, and 6.x 
Ubuntu 9.10, 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 13.04, and 13.10 
Fedora 11, 12, 13, 14, 15, 16, 17, and 18 
SUSE Linux Enterprise Server 10 and 11 
Debian 4, 5, and 6 
CentOS 5.x and 6.x 
Oracle Linux 5.x and 6.x – both Unbreakable Enterprise Kernel and Red Hat Compatible 
Kernel 
Before installing the product on a system that does not use RPM Package Manager, such as 
an Ubuntu system, you need to install this manager manually; for example, by running the 
following command (as the root user): apt-get install rpm 

Acronis Backup & Recovery 11.5 Agent for Hyper-V 
Windows Server 2008 (x64) with Hyper-V 
Windows Server 2008 R2 with Hyper-V 
Microsoft Hyper-V Server 2008/2008 R2 
Windows Server 2012/2012 R2 with Hyper-V 
Microsoft Hyper-V Server 2012/2012 R2 

Acronis Backup & Recovery 11.5 Agent for ESX(i) (Virtual Appliance) 

This agent is delivered as a virtual appliance for running on an ESX(i) host. 

VMware ESX Infrastructure 3.5 Update 2+ 
VMware ESX(i) 4.0, 4.1, 5.0, 5.1, and 5.5 

Acronis Backup & Recovery 11.5 Agent for ESX(i) (Windows) 

This agent is delivered as a Windows application for running in any operating system listed above for 
Agent for Windows (Virtual Edition). 

Components for centralized management 
Acronis Backup & Recovery 11.5 Management Server, Acronis License Server, Acronis Backup & 
Recovery 11.5 Storage Node 

Windows XP Professional SP3 (x86, x64) 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Vista – all editions except for Vista Home Basic and Vista Home Premium (x86, x64) 
Windows Server 2008 – Standard, Enterprise, and Datacenter editions (x86, x64) 
Windows Small Business Server 2008 
Windows 7 – all editions except for the Starter and Home editions (x86, x64) 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, and Foundation editions 
Windows MultiPoint Server 2010/2011 
Windows Small Business Server 2011 – all editions 
Windows 8/8.1 – all editions except for the Windows RT editions (x86, x64) 
Windows Server 2012/2012 R2 – all editions 
Windows Storage Server 2003/2008/2008 R2/2012 
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Acronis Backup & Recovery 11.5 Management Console 

Windows XP Professional SP2+ (x86, x64) 
Windows 2000 SP4 – all editions except for the Datacenter edition 
Windows Server 2003/2003 R2 – Standard and Enterprise editions (x86, x64) 
Windows Small Business Server 2003/2003 R2 
Windows Vista – all editions (x86, x64) 
Windows Server 2008 – Standard, Enterprise, Datacenter, and Web editions (x86, x64) 
Windows Small Business Server 2008 
Windows 7 – all editions (x86, x64) 
Windows Server 2008 R2 – Standard, Enterprise, Datacenter, Foundation, and Web editions 
Windows MultiPoint Server 2010/2011 
Windows Small Business Server 2011 – all editions 
Windows 8/8.1 – all editions except for the Windows RT editions (x86, x64) 
Windows Server 2012/2012 R2 – all editions 
Windows Storage Server 2003/2008/2008 R2/2012 

 

1.6 System requirements 
The components installed in operating systems 
To calculate the total required disk space, add up the values specified in the third and fourth columns 
of the table for the components you are planning to install. 

Component Memory (above 
the OS and 
running 
applications) 

Disk space required 
during installation or 
update 

Disk space occupied 
by the component(s) 

Additional 

The components installed in Windows 

Complete installation  350 MB 5.8 GB 4.4 GB 

including SQL 
Express Server 

 

Agent Core 140 MB 420 MB 270 MB  

Agent for Windows 375 MB 1 GB 660 MB  

Agent for VMware vSphere 
ESX(i) (Windows) 

90 MB 140 MB 100 MB  

Agent for Hyper-V 80 MB 60 MB 30 MB  

Agent for Exchange 100 MB 170 MB 90 MB  

Bootable Media Builder 370 MB 1.3 GB 880 MB CD-RW or DVD-RW 
drive  

Management Console 180 MB 490 MB 330 MB Screen resolution 
800*600 pixels or 
higher  
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Management Server 
(up to 200 managed 
machines) 

350 MB 940 MB 

490 MB for SQL 
Express Server 

640 MB 

260 MB for SQL 
Express Server 

 

Management Server 
(more than 200 managed 
machines) 

Refer to the following Acronis Knowledge Base article: 
http://kb.acronis.com/content/40678. 

Wake-on-LAN Proxy 70 40 MB 15 MB  

Storage Node 
(general requirements) 

180 MB 470 MB 290 MB 

When using a tape 
library, space 
required for tapes 
database: approx. 
1 MB per 10 
archives 

 

Storage Node 
(requirements for using 
Deduplication) 

 Minimum 8 GB of RAM. 

 64-bit platform. 

For more information, see “Deduplication best practices” in the product Help or 
the User Guide. 

License Server 65 MB 60 MB 40 MB  

PXE Server 80 MB 95 MB 60 MB  

Tray Monitor 65 MB 25 MB 10 MB  

The components installed in Linux 

Agent for Linux 120 MB 200 MB 210 MB  

Bootable Media Builder 130 MB 300 MB 330 MB  

Management Console 120 MB 100 MB 200 MB  

The components installed on VMware ESX(i) server 

Agent for VMware vSphere 
ESX(i) (Virtual Appliance) 

1 GB 

(the Virtual 
Appliance 
memory setting) 

6 GB 6 GB CPU number: 

2 (the default 
Virtual Appliance 
setting) 

4-8 (recommended 
if backing up 5-10 
VMs 
simultaneously) 

CPU reservation: 
minimum 300 MHz 
recommended 

Network interface card or virtual network adapter is a common requirement for all the components. 

Bootable media 
Media type Memory ISO image size Additional 
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Based on Windows PE  1 GB 410 MB  

Linux-based 370 MB 490 MB  
 

2 Installing Acronis Backup & Recovery 11.5 
This section helps answer questions that might arise during the product installation. 
 

2.1 Installation in Windows 
This section describes installation of Acronis Backup & Recovery 11.5 components on a machine 
running Windows. 
 

2.1.1 Ways of installation in Windows 
Components of advanced editions of Acronis Backup & Recovery 11.5 can be installed in different 
ways. Based on the size and structure of your environment, choose any of the ways of installation 
described in this section. 

You can combine two or more ways of installation. For example, you can perform interactive 
installation of the management console and the management server, and then remotely install the 
agents to multiple machines. 

By using interactive or Web-based installation, you can install any component. Other ways of 
installation are intended primarily for installing the agents. 

Interactive installation (p. 20) 
In this way of installation, you run a self-contained setup program and follow the on-screen 
instructions. 

Advantages: The setup program includes all components for Windows. 

Disadvantages: Large size of the setup program. 

Usage examples: 

 Installing the management console, management server and storage nodes. 
 Installing agents on a small number of machines. 

Web-based installation (p. 26) 
In this way of installation, you run a lightweight setup program and follow the on-screen instructions. 
The setup program downloads from the Acronis Web site only the components that you selected to 
install. 

Advantages: Small size of the setup program. 

Disadvantages: Large amounts of the same data may be transferred over the Internet (for example, 
when installing the agent on many machines). To overcome this disadvantage, save the downloaded 
installation packages (p. 26) to a network folder. 
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Usage examples: Installing agents in a small network with slow Internet access (you do not need to 
download the large setup program from the Acronis Web site). 

Remote installation (p. 47) 
Prerequisite: the management console must be already installed. 

In this way of installation, you install the software remotely on a number of machines. You can do 
this from the management console’s welcome screen or when adding machines to the management 
server. 

Advantages: Installation can be performed centrally by an administrator and is transparent to end 
users. 

Disadvantages: Several preparatory steps (p. 48) must be performed on the target machines before 
installation. 

Usage examples: 

 Installing agents on a large number of machines in a local network. 
 Adding a machine without an agent to the management server. 

Unattended installation (p. 27) 
In this way of installation, you run installation packages (.msi files) with command-line parameters. 

Advantages: Installation can be performed by a script. 

Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst 
file). 

Usage examples: Installing agents on a large number of machines running Windows. 

Installation through Group Policy (p. 30) 
In this way of installation, you deploy installation packages (.msi files) in an Active Directory domain 
by using Group Policy. 

Advantages: Installation can be performed centrally by an administrator in an entire domain. It is 
performed under a system account and is transparent to end users. 

Disadvantages: Installation is harder to configure (you may need to create a transform, or an .mst 
file). The machines must be in a domain. 

Usage examples: Installing agents on a large number of machines in an Active Directory domain. 

Installation from the management server Web page (p. 35) 
Prerequisite: the management server must be already installed. 

In this way of installation, you go to the Web page on the management server, and install the 
software without having to specify installation settings. 

Advantages: 

 Installation can be performed by an end user on any machine with a supported Web browser. 
 The components are downloaded from the local network instead of over the Internet. 
 The end user does not need to specify installation settings. 
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 The machine can be automatically registered on the management server. 

Disadvantages: The end user still must have rights to install software on the machine (for example, 
be a local administrator on it). 

Usage examples: 

 Enabling laptop users (who may connect to the corporate network at irregular intervals) to install 
the program on their own. 

 Accessing installation packages in a network that does not allow sharing folders. 
 

2.1.2 Local installation 
You have a choice between a setup program that contains all components, and a lightweight setup 
program that will download from the Acronis Web site only the components that you select to install. 

Installation can be performed in the interactive or the unattended mode. 
 

2.1.2.1 Preparation 
Network port. Acronis Backup & Recovery 11.5 uses TCP port 9876 for local installation and for 
communication between components. The setup program automatically opens this port through 
Windows Firewall. If you use a different firewall, make sure that the port is open for both incoming 
and outgoing requests through that firewall. 

Encryption software. If you are planning to use disk-level encryption software, such as PGP Whole 
Disk Encryption, make sure to install such software before installing Acronis Backup & Recovery 11.5. 
 

2.1.2.2 Interactive installation in advanced editions 
You can install Acronis Backup & Recovery 11.5 on the local machine by using the typical or the 
custom installation. Typical installation is the easiest way to install Acronis Backup & Recovery 11.5. 
Most of the installation parameters will be set to their default values. During custom installation, 
you will be able to select the components to be installed and to specify additional parameters. 

Note: When canceling the installation process, only the last package is removed. Other components, if any, 
remain installed. 

Typical installation 
1. Log on as an administrator and start the Acronis Backup & Recovery 11.5 setup program. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Accept the terms of the license agreement. 
4. Select one or more machine roles, depending on what you want this machine to do. 

Based on your choice, the corresponding components (p. 23) of Acronis Backup & Recovery 11.5 
will be selected for installation.  

5. If you chose to back up this machine's data, and the machine has applications that Acronis 
Backup & Recovery 11.5 can back up, select the applications that you want to protect with the 
application-specific backup. 
Based on your choice, additional components, such as Agent for Exchange or Agent for Hyper-V, 
will be selected for installation. 
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6. If prompted, specify one or more of the following parameters, depending on the component 

selection: 
 Installation mode (trial or full) (p. 22). 
 Whether to register the components on the management server (p. 26). 
 Credentials for Microsoft SQL Server instances installed on the machine (p. 61). 
 Whether the machine will participate in the Acronis Customer Experience Program (CEP). 

7. On the summary page, review the list of components that will be installed, and the installation 
settings for those components. Click Install to start the installation. 

Custom installation 
1. Log on as an administrator and start the Acronis Backup & Recovery 11.5 setup program. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Accept the terms of the license agreement. 
4. Select the I want to manually select the Acronis components and customize the installation 

process check box.  
You can also select one or more of the machine roles, depending on what you want this machine 
to do. Based on your choice, the corresponding components (p. 23) of Acronis Backup & 
Recovery 11.5 will be selected for installation. 

5. [Optional] In the components tree, select additional components or clear selection of the 
components that you do not want to install. 
Tips. Agent for VMware vSphere ESX(i) (Windows), Wake-on-LAN Proxy, and some smaller 
features can be installed only by using the components tree. 
You may want to disable Components for Remote Installation from being saved every time you 
install the management console, because the installation files take about 900 MB of disk space. 

6. If prompted, specify one or more of the following parameters, depending on the component 
selection: 
 Installation mode (trial or full) (p. 22). 
 The name or IP address of the license server that Agent for ESX(i) (Windows) will use. 
 The folder where the product will be installed. 
 Whether to install the product for all users or only for the current user. 
 Credentials for the Acronis Backup & Recovery 11.5 component services (p. 23). By default, 

the setup program will create a dedicated user account for each service. 
 The names of Microsoft SQL servers to be used by Acronis Backup & Recovery 11.5 

Management Server (p. 25). 
 Whether to register the components on the management server (p. 26). 
 The names of users who will be allowed to connect to the machine remotely (p. 26). 
 The name or IP address of the VMware vCenter Server or ESX(i) server whose virtual 

machines Agent for ESX(i) (Windows) will back up. Specify the user name and password for 
logging on to that server. If you do not want to specify the server, click I will specify the 
server later. 
To access this setting after the agent has been installed, connect the console to the machine with the 
agent and select from the top menu Options > Machine options > Agent for ESX(i). 

 Whether to enable the management server Web page. (If enabled, specify the port for the 
Web page). (p. 35) 
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 Credentials for Microsoft SQL Server instances installed on the machine (p. 61). 
 Whether the machine will participate in the Acronis Customer Experience Program (CEP). 

7. On the summary page, review the list of components that will be installed and the installation 
settings for those components. Click Install to start the installation. 

 

Installation mode 
When installing agents, choose the installation mode depending on whether you have a license key 
or subscription. 

Installing in the trial mode 
 During typical installation: Select I want to start a free trial. 
 During custom installation: In License for backup of ..., select Trial mode, and then click Next. 

The product will be installed in the trial mode (p. 4). 

Installing for online backup only 
1. [During typical installation only] Select I purchased a license or a subscription, and then click 

Next. 
2. In License for backup of ..., select Online backup only - license not required. 
3. Click Next, and then click Yes in the confirmation window. 

Prior to backing up to the online storage, you need to activate a subscription to the online backup 
service on the machine. Please do not try to import the subscription keys to Acronis License Server or 
type them in the installation wizard windows. 

Note  Agent for Exchange does not support online backup. 

Installing in the full mode 
1. [During typical installation only] Select I purchased a license or a subscription, and then click 

Next. 
2. Click Add licenses. 
3. Choose whether to take licenses from a license server or to store them locally on the machine.  
 To take licenses from a license server, select the Use the following license server check box, 

and then specify the name or IP address of the license server. If the license server does not 
contain the required license keys, type the license keys or import them from a text file. 
We recommend specifying the management server as the license server, unless you already 
have a separate license server. If the management server is being installed, the local machine 
is selected by default.  

 To store the machine's licenses on the machine itself, ensure that the license server is not 
selected. Otherwise, clear the Use the following license server check box. Then, type the 
license keys or import them from a text file. 

4. Click OK to return to the license selection window. 
5. If the license server (or the set of licenses that you entered) contains licenses for more than one 

edition, select the product edition that you want to install. By default, the cheapest license 
applicable to the machine’s operating system is selected. 

6. If the license server (or the set of licenses that you entered) contains licenses for add-ons, such 
as Universal Restore, the check boxes corresponding to the add-ons are automatically selected. If 
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a license for the required add-on is missing, click Add licenses, and then add the license as 
described in step 3. 

 

Components installed during typical installation 
When performing the typical installation on a machine, you select the roles you want the machine to 
perform. Based on your choice, the following components of Acronis Backup & Recovery 11.5 will be 
installed. 

 Back up this machine's data. 
 Agent Core 
 Agents (depending on the data types that are present on the machine): 
 Agent for Windows 
 Agent for Microsoft Exchange Server 
 Agent for Microsoft SQL Server (single-pass) 
 Agent for Microsoft Active Directory (single-pass) 
 Agent for Hyper-V 

 Management Console 
 Command-Line Tool 

 Centrally monitor and configure the backing up of physical and virtual machines. 
 Management Server  
 Management Console 
 Components for Remote Installation* 
 Command-Line Tool 
 License Server 

 Store the backups of other machines on this machine. 
 Storage Node  
 Command-Line Tool 

 Connect to remote machines. 
 Management Console 
 Bootable Media Builder  
 Components for Remote Installation* 
 Command-Line Tool 

* The components are installed only if the setup file is in a local folder. 
 

Specifying credentials for Acronis services 
The following Acronis Backup & Recovery 11.5 components run as services: Acronis Backup & 
Recovery 11.5 agents, Acronis Backup & Recovery 11.5 Management Server, and Acronis Backup & 
Recovery 11.5 Storage Node. When installing any of these components, you need to specify the 
account under which the component's service will run. 

All Acronis Backup & Recovery 11.5 agents installed on a machine use the common Acronis Managed Machine Service, also 
referred to as the agent service. 
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For each service, you can choose to create a new user account or specify an existing account of a 
local or domain user; for example: .\LocalUser or DomainName\DomainUser 

By default, the setup program will create a new dedicated account for each of the services. 

When to consider an existing account? 
New accounts fit most cases. Consider existing accounts in the following cases: 

 The machine is a domain controller in an Active Directory domain. 
You must specify existing accounts (or the same account) for each service. For security reasons, 
the setup program does not automatically create new accounts on a domain controller. 

 You are installing an agent on a failover cluster node.  
When installing an agent on a failover cluster node, such as a Hyper-V cluster node or a cluster 
node of Microsoft Exchange Server, specify an existing account of a domain user for the agent 
service. The account must have administrative privileges on each of the cluster nodes. With this 
account the agent will be able to access the clustered resources on any of the nodes. 
Alternatively, you can choose to create a new account for the agent. Then, when creating 
centralized backup plans or recovery tasks, you will need to specify credentials for the domain 
account with the necessary privileges. 

 You want the management server to use an existing Microsoft SQL server. 
Specify an existing account for the management server service if the management server and the 
SQL server are installed on different machines and you want to use Windows Authentication for 
the SQL server. For more details, see “Specifying Microsoft SQL servers” (p. 25). 

Privileges for accounts 
Both existing and newly created accounts are given the following privileges: 

 The accounts for the agent service and the storage node service are included in the Backup 
Operators group. 
New accounts for the agent service and the storage node service are also included in the 
Administrators group. If you specify an existing account for the storage node service, we 
recommend that this account be a member of the Administrators group. Otherwise, the service 
may lack access to some Windows resources. For security reasons, the setup program does not 
automatically include existing accounts in the Administrators group. 

 The account for the management server service is included in the Acronis Centralized Admins 
group. 

 All three accounts are assigned the Log on as a service user right. 
 All three accounts are granted the Full Control permission on the folder 

%PROGRAMDATA%\Acronis (in Windows XP and Server 2003, 
%ALLUSERSPROFILE%\Application Data\Acronis) and on its subfolders. 

 Each of the three accounts is granted the Full Control permission on certain registry keys in the 
following key: HKEY_LOCAL_MACHINE\SOFTWARE\Acronis. 

 The account for the agent service is assigned the Adjust memory quotas for a process, Replace a 
process level token and Modify firmware environment values user rights. 

Tips for further usage 
 The new accounts for the agent service, the management server service, and the storage node 

service have the names Acronis Agent User, AMS User, and ASN User, respectively. 
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 If the machine is part of an Active Directory domain, make sure that the domain's security 

policies do not prevent the accounts described in this section (whether existing or newly created) 
from having the above listed user rights. 

 After the installation, avoid specifying a different account for a component's service. Otherwise, 
the component may stop working. If you must specify a different account, make sure that the 
new account is granted the above listed privileges. 

 

Specifying Microsoft SQL servers 
When installing Acronis Backup & Recovery 11.5 Management Server, you need to specify the 
Microsoft SQL servers that the management server will use: 

 The operational SQL server ensures synchronization of the Acronis Backup & Recovery 11.5 
components. It stores a database with rapidly changing operational data. Therefore, we 
recommend that it reside on the same machine as the management server. 

 The reporting SQL server stores the operation log and statistics. The databases stored on this 
server may become considerably large over time. The reporting SQL server can be the same as 
the operational SQL server, or it can be a different server that is installed on the same or a 
different machine. 

By default, a new instance of SQL Server will be installed on the machine and used as both the 
operational and the reporting SQL server. 

The following version of SQL Server will be installed: 

 In the Windows 8/8.1 and Windows Server 2012/2012 R2 operating systems: Microsoft SQL 
Server 2008 Express. 

 In other Windows operating systems: Microsoft SQL Server 2005 Express. 

The name of the instance is ACRONIS. Click Change if you want to specify a different name or select 
an existing SQL server instance. 

Selecting an existing SQL server instance 
You can select any edition of Microsoft SQL Server 2005, Microsoft SQL Server 2008/2008 R2, or 
Microsoft SQL Server 2012. The instance you choose can also be used by other programs. 

Before selecting an instance installed on another machine, make sure that SQL Server Browser 
Service and the TCP/IP protocol are enabled on that machine. For instructions on how to start SQL 
Server Browser Service, refer to: http://msdn.microsoft.com/en-us/library/ms189093.aspx. You can 
enable the TCP/IP protocol by using a similar procedure. 

Instance name. Specify the instance name in the form MachineName\InstanceName. For example, 
specify: dbserver\MyDatabases. If only one SQL server instance is installed on the machine, you can 
specify just the machine name. 

Authentication. Choose whether the management server will use Windows Authentication or SQL 
Server Authentication to connect to the SQL server. 

 If you choose Windows Authentication (recommended by Microsoft as more secure), the 
management server will connect using the account of the management server service (p. 23). 
If the SQL server and the management server are installed on different machines, make sure that 
the account: 
 Exists on both machines. For example, it can be a domain user account. 
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 Has rights to create databases on the SQL server. The easiest way to ensure this is to include 

the account in the Administrators group on the SQL server’s machine before proceeding with 
the installation. You can remove the account from this group after the installation is 
complete. 

 If you choose SQL Server Authentication, specify the login name and password of a SQL server 
login account that has rights to create databases on the SQL server. 

 

Registering components on the management server 
When installing an Acronis Backup & Recovery 11.5 agent or Acronis Backup & Recovery 11.5 Storage 
Node, you need to specify whether to register these components on Acronis Backup & Recovery 11.5 
Management Server. 

After the agent is registered on the management server, the machine can be centrally managed by 
management server administrators. Such a machine is called a registered machine. If you install 
another agent at a later time, you will not need to register it. 

After the storage node is registered on the management server, registered machines can back up 
data to and recover data from the storage node's centralized vaults. 

To register the agent and/or the storage node during installation (recommended) 
1. Click Register now. 
2. Specify the name or IP address of the machine with the management server. That machine must 

be online. It can be the local machine—for example, when the management server is among the 
components you are installing.  

3. Specify the user name and password of a user who is a member of the Acronis Centralized 
Admins group on the management server's machine. If you are installing the management server 
on the local machine, specify the user name and password of a member of the Administrators 
group. 

To skip registration 
 Click I will register the machine later (or I will register the components later). 

After the installation, you can register the components on the management server or remove them 
from it, through the management server's interface. 
 

Specifying users allowed to connect remotely 
When installing an agent or the management server (or both), you need to specify the list of users 
whom you want to allow to manage the machine remotely by using Acronis Backup & Recovery 11.5 
Management Console. 

By default, the list contains all members of the Administrators group on the machine; note that this 
includes the domain administrators (if the machine is in an Active Directory domain). 

The setup program creates the Acronis Remote Users group and adds the listed users to it. By adding 
or removing group members, you will add or remove users who are allowed to connect to the 
machine remotely. 
 

2.1.2.3 Web-based installation 
The procedure for Web-based installation is identical to that for interactive installation (p. 20). 
Web-based installation is available only in advanced editions. 
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During a Web-based installation, only the components that you are currently installing are 
downloaded from the Acronis Web site. You should keep this in mind if you are planning to install 
components from this machine remotely (p. 47) at a later time. To ensure that all components that 
can be installed remotely are present on the machine, consider using local installation instead. 

When performing Web-based installation on a large number of machines, you may want to avoid 
multiple downloads of the same component over the Internet. To do this: 

1. In your local network, create a shared folder and make it available to all machines where you 
want to install Acronis Backup & Recovery 11.5. 

2. On the first of these machines, do the following: 
a. Run the setup program for Web-based installation. 
b. When selecting the machine roles, select the I want to manually select the Acronis 

components… check box. 
c. When selecting where to install the components, select the Save the downloaded 

installation files check box, and then specify the shared folder that you created. 
d. Proceed with the installation. 
The necessary installation packages will be downloaded to the shared folder. 

3. Repeat step 2 on the remaining machines. The setup program will reuse the installation files that 
are already in the folder, instead of downloading them again. Any other necessary files will be 
downloaded to the folder. 

 

2.1.2.4 Unattended installation 
Components of Acronis Backup & Recovery 11.5, such as Acronis Backup & Recovery 11.5 Agent for 
Windows, can be installed in the unattended mode, as opposed to the interactive mode. 

This section describes unattended installation and update by using Windows Installer (the msiexec 
program). In an Active Directory domain, another way of performing unattended installation or 
update of a supported component is through Group Policy—see "Installing the agent through Group 
Policy (p. 30)". 

Some components require a file known as a transform (an .mst file). Use of a transform for other 
components is optional. 

The following table summarizes components and features that can be installed or updated in the 
unattended mode. 

 Component name msi file name Requires a 
transform? 

Agent Core 
(required by any 

agent) 

Agent Core AcronisAgentCore.msi + 

Agents 

Agent for Windows (p. 6) AcronisAgentWindows.msi + 

Agent for VMware vSphere 
ESX(i) (Windows) (p. 7) 

AcronisAgentESX.msi + 

Agent for Hyper-V (p. 8) AcronisAgentHyperV.msi + 

Agent for Microsoft 
Exchange Server (p. 8) 

AcronisAgentExchange.msi + 
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Agent features 

Deduplication (p. 6) AcronisDeduplication.msi + 

Universal Restore (p. 6) AcronisUniversalRestore.msi + 

Agent for SQL (p. 8) AcronisAgentMsSqlSinglePass.msi + 

Agent for Active Directory 
(p. 9) 

AcronisAgentADSinglePass.msi + 

Media builder Bootable Media Builder (p. 
11) 

AcronisBootableComponentsMediaBuilder.msi - 

Management 
console 

Management Console (p. 
10) 

AcronisManagementConsole.msi - 

 

Preparation 
To create a transform for a component, you need the configuration script mst_gen.vbs.  

This script is located in the folder where Acronis Backup & Recovery 11.5 Management Console is 
installed. The default folder path is:  

 %ProgramFiles%\Acronis\BackupAndRecoveryConsole in 32-bit Windows 
 %ProgramFiles(x86)%\Acronis\BackupAndRecoveryConsole in 64-bit Windows 

If the management console is installed on a different machine, you can copy the script from that 
machine. See also “Examples of creating a transform” later in this section.  

Order of installation for an agent 
When you install an agent, first install the Agent Core component (if it is not yet installed), then the 
agent itself, and then the agent features. 

Installation procedure 
To install or update a component in the unattended mode 
1. Start the setup program. 
2. Click Extract installation files (when using the standard setup program) or Save installation files 

(when using the Web-based setup program). 
3. Extract the component's installation package. 
4. If you are installing a component that uses a transform, create the transform by running the 

configuration script. Otherwise, skip this step. 
For example, the following command creates a transform to install Agent for Windows with the 
license key ABCDE-54321: 
mst_gen.vbs /msi_path C:\AcronisAgentWindows.msi /serial ABCDE-54321 

See the examples later in this section. The complete syntax of the configuration script is 
described in "Configuration script parameters" (p. 33). 

5. Do either of the following, depending on whether you are installing or updating the component: 
 If you are installing the component, run Windows Installer (the msiexec program) as 

follows: 
When installing a component that requires a transform (in this example, Agent for 
Windows): 
msiexec /i c:\AcronisAgentWindows.msi TRANSFORMS=AcronisAgentWindows.mst /qb 



29 Copyright © Acronis International GmbH, 2002-2013. 

 

 
Otherwise (in this example, when installing the management console): 
msiexec /i c:\AcronisManagementConsole.msi /qb 

 If you are updating the component, run Windows Installer as follows: 
When updating a component that requires a transform (in this example, Agent for Windows): 
msiexec /i C:\AcronisAgentWindows.msi TRANSFORMS=C:\AcronisAgentWindows.mst 
ADDLOCAL=ALL /qb 

Otherwise (in this example, when updating the management console): 
msiexec /i C:\AcronisManagementConsole.msi ADDLOCAL=ALL /qb /l*v C:\log.log 

Examples of creating a transform 
Transform for Agent Core. The following command creates a transform for the installation package 
of the Agent Core component: 

mst_gen.vbs /msi_path C:\AcronisAgentCore.msi /account mydomain\agentuser MyPassWd 
/ams_address managementsrv /ams_user adminname AdminPassWd 

After unattended installation with this transform: 

 The agents’ service will run under the agentuser domain user account (of the mydomain 
domain) whose password is MyPassWd. 

 The agents will be registered on Acronis Backup & Recovery 11.5 Management Server installed 
on the managementsrv machine; adminname and AdminPassWd are respectively the user name 
and password of a management server administrator. 

Transform for Agent for Windows. The following command creates a transform for the installation 
package of Agent for Windows: 

mst_gen.vbs /msi_path C:\AcronisAgentWindows.msi /license_server licensesrv 
/product AS 

After unattended installation with this transform: 

 The agent will use a license for the Acronis Backup & Recovery 11.5 Advanced Server edition, by 
taking it from the license server installed on the licensesrv machine. 

Similarly, you can create transforms for the agent features such as Universal Restore. 
 

2.1.2.5 Update 
To update one or more Acronis Backup & Recovery 11.5 components: 

1. Run the setup program of the updated version of Acronis Backup & Recovery 11.5. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Click Update. 
4. If prompted, specify the license keys, by typing them manually or by specifying the license server. 
5. Follow the on-screen instructions. 

Updating components in the unattended mode 
For information about updating a component in the unattended mode, see "Unattended installation 
(p. 27)". 
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2.1.3 Installing the agent through Group Policy 
You can centrally install (or deploy) Acronis Backup & Recovery 11.5 Agent for Windows onto 
machines that are members of an Active Directory domain, by using Group Policy. Group Policy is a 
mechanism available in Microsoft Windows 2000 Server and later Windows server operating 
systems. 

In this section, you will find out how to set up a Group Policy object to deploy Acronis Backup & 
Recovery 11.5 Agent for Windows onto machines in an entire domain or in its organizational unit. 

Every time a machine logs on to the domain, the resulting Group Policy object will ensure that the 
agent is installed on the machine. 
 

2.1.3.1 Prerequisites 
Before proceeding with agent deployment, make sure that: 

 You have an Active Directory domain with a domain controller running Microsoft Windows 
Server 2003 or later. 

 You are a member of the Domain Admins group in the domain. 
 You know the license key or the name or IP address of a machine where Acronis License Server is 

installed. 
 You have a machine running Windows, with Acronis Backup & Recovery 11.5 Management 

Console installed on the machine. 
 

2.1.3.2 Preparing the agent's deployment 
Step 1: Extracting installation packages 
You need to create a shared folder that will contain the installation packages (provided as .msi files), 
and extract the packages there. 

1. On the domain controller (or any other machine in the domain), create a folder—for example: 
D:\Acronis 

2. Start the Acronis Backup & Recovery 11.5 setup program. 
3. Click Extract installation files. 
4. Select the Agent for Windows (AcronisAgentWindows.msi) and Agent Core 

(AcronisAgentCore.msi) check boxes. 
5. If you are installing Acronis Backup & Recovery 11.5 Deduplication, select the Deduplication 

(AcronisDeduplication.msi) check box. 
6. If you are installing Acronis Backup & Recovery 11.5 Universal Restore, select the Universal 

Restore (AcronisUniversalRestore.msi) check box. 
Note: In Acronis Backup & Recovery 11.5 Virtual Edition and Advanced Server SBS Edition, the Universal 
Restore feature is already enabled, so you do not need to install it separately. 

7. In Extract to, type the name of the folder that you just created, or click Browse and select the 
folder.  

8. Click Extract. 
9. Share the folder where you placed the installation packages. Make sure that domain users can 

access the shared folder—for example, by leaving the default sharing settings for Everyone. 
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Step 2: Configuring the installation packages 
Important: Skip this step when reinstalling or updating the agent. 

You need to configure the installation packages of the Agent Core and Agent for Windows 
components by running the configuration script. The script is installed along with the management 
console. By default, the script is located in the folder 
%ProgramFiles%\Acronis\BackupAndRecoveryConsole. If the management console is installed on a 
different machine, you can copy the configuration script from that machine. 

The configuration script creates a transform (also known as a modification, a modification file, or an 
.mst file) for an installation package. 

1. In the Start menu, click Run, and then type: cmd 
2. Click OK. 
3. Change the current folder to the one where the configuration script mst_gen.vbs is located, by 

running commands such as: 
C: 
cd "C:\Program Files\Acronis\BackupAndRecoveryConsole" 

4. Run the configuration script for the Agent Core and for the Agent for Windows components; for 
example, as follows: 
mst_gen.vbs /msi_path D:\Acronis\AcronisAgentCore.msi 
 

mst_gen.vbs /msi_path D:\Acronis\AcronisAgentWindows.msi /license_server 
licensesrv /product AS 

Note: You must include a complete path to the installation package, even if the package is in the same 
folder as the configuration script. 

For the complete syntax of the configuration script, see Configuration script parameters (p. 33). 
See also “Examples of creating a transform” in Unattended installation (p. 27). 

The installation packages are ready for deployment. You now need to create Group Policy objects, as 
described in Setting up the Group Policy objects (p. 31). 
 

2.1.3.3 Setting up the Group Policy objects 
Use this procedure to set up a Group Policy object (GPO) for agent deployment in the entire domain 
or in its organizational unit. The agent will be installed on each machine which is a member of the 
domain or the organizational unit immediately after Windows starts on that machine. 

Prerequisites 
 You must be logged on to the domain controller as a domain administrator; if the domain has 

more than one domain controller, log on to any of them as a domain administrator. 
 If you are planning to deploy the agent in an organizational unit, make sure that the 

organizational unit exists in the domain. 
 Make sure that you have completed the steps described in Preparing the agent's deployment (p. 

30). 

Step 1: Creating Group Policy objects 
1. In the Start menu, point to Administrative Tools, and then click Active Directory Users and 

Computers (in Windows Server 2003) or Group Policy Management (in Windows Server 2008). 
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2. In Windows Server 2003: 
 Right-click the name of the domain or organizational unit, and then click Properties. In the 

dialog box, click the Group Policy tab, and then click New. 
In Windows Server 2008: 
 Right-click the name of the domain or organizational unit, and then click Create a GPO in this 

domain, and Link it here. 
3. Name the new Group Policy object Acronis Agent 
4. Similarly, create another Group Policy object and name it Acronis Core 
5. Make sure that the Acronis Agent object is higher in the list than the Acronis Core object. 

Step 2: Configuring the Group Policy object for the agent 
1. Open the Acronis Agent Group Policy object for editing, as follows: 
 In Windows Server 2003, click the Group Policy object, and then click Edit. 
 In Windows Server 2008, under Group Policy Objects, right-click the Group Policy object, and 

then click Edit. 
2. In the Group Policy object editor snap-in, expand Computer Configuration, and then expand 

Software Settings. 
3. Right-click Software installation, then point to New, and then click Package. 
4. Select the agent's installation package in the shared folder that you previously created, and then 

click Open. 
5. In the Deploy Software dialog box, click Advanced, and then click OK. 
6. If you are reinstalling or updating the agent, do nothing. 

If you are installing the agent, do the following: 
 On the Modifications tab, click Add, and then select the transform that you previously 

created; the transform file has the name AcronisAgentWindows.mst and is located in the 
same folder as the agent's installation package. 

7. Click OK to close the Deploy Software dialog box. 
8. If you are installing Acronis Backup & Recovery 11.5 Deduplication and/or Acronis Backup & 

Recovery 11.5 Universal Restore, do the following for the appropriate installation package: 
a. Right-click Software installation, then point to New, and then click Package. 
b. Select the installation package in the shared folder and then click Open. 
c. In the Deploy Software dialog box, click Assigned and then click OK. 

Step 3: Configuring the Group Policy object for the Agent Core component 
1. Open the Acronis Core Group Policy object for editing, as follows: 
 In Windows Server 2003, click the Group Policy object, and then click Edit. 
 In Windows Server 2008, under Group Policy Objects, right-click the Group Policy object, and 

then click Edit. 
2. In the Group Policy object editor snap-in, expand Computer Configuration, and then expand 

Software Settings. 
3. Right-click Software installation, then point to New, and then click Package. 
4. Select the AcronisAgentCore.msi installation package in the shared folder that you previously 

created, and then click Open. 
5. In the Deploy Software dialog box, click Advanced, and then click OK. 
6. If you are reinstalling or updating the agent, do nothing. 
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If you are installing the agent, do the following: 
 On the Modifications tab, click Add, and then select the transform that you previously 

created; the transform file has the name AcronisAgentCore.mst and is located in the same 
folder as the component’s installation package. 

7. Click OK to close the Deploy Software dialog box. 
 

2.1.4 Configuration script parameters 
The configuration script mst_gen.vbs creates an .mst file (known as a transform, a modification, 
or a modification file) for the installation package of an Acronis component such as Acronis Backup & 
Recovery 11.5 Agent for Windows. 

By using the transform together with the installation package, you can install the component in the 
unattended mode either by running the installation package manually or by deploying it through 
Group Policy. 

The following is the complete syntax of the configuration script: 

mst_gen.vbs 
    /msi_path <Full path> 
    [/target_dir <Installation folder>] 
    [/account <User name> <Password>] 
    [/remote_users <User1>;<User2>;…;<UserN>] 
    [/ams_address <Management server> /ams_user <Administrator name> 
<Password>] 
    [/cep_enabled] 
    [{/serial <License key> [/old_serial <old license 
key>] | /license_server <License server> /product <Edition code> 
| /online_backup | /advanced_online_backup}] 
    [/current_user] 

Brackets ([]) denote parameters that are optional or that apply only to some components. Braces ({}) 
denote mutually exclusive sets of parameters; each set is separated by a pipe (|). 

The following is the description of each parameter and the list of components it applies to. 

Parameters that apply to any component 
/msi_path <Full path> 

Specifies a full path to the component's installation package. Enter a local path, such as 
D:\folder\AcronisAgentWindows.msi; or enter a universal naming convention (UNC) path, such 
as \\server\folder\AcronisAgentWindows.msi. 

/target_dir <Installation folder> 

Specifies the folder where to install the component. 
Without this parameter, the component will be installed to the default folder: 
%ProgramFiles%\Acronis (in a 32-bit version of Windows) or %ProgramFiles(x86)%\Acronis (in a 
64-bit version of Windows). 

Parameter that applies only to the Agent Core and Management Console components 

The following parameter applies only to the installation packages AcronisAgentCore.msi and 
AcronisManagementConsole.msi. 
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/cep_enabled 

Specifies whether a machine with any of these components will participate in the Acronis 
Customer Experience Program (CEP). 
With this parameter, information about the hardware configuration, about the most and least 
used features, and about any problems will be automatically collected from the machine and 
sent to Acronis on a regular basis. The kind of information to be sent depends on which of the 
above components will be installed on the machine. The terms of participation can be found on 
the Customer Experience Program Web page. 
Without this parameter, the information will not be sent. 

Parameters that apply only to the Agent Core component 

The following parameters apply only to the installation package AcronisAgentCore.msi. 

/account <User name> <Password> 

Specifies the user name and password of the user account under which Acronis Managed 
Machine Service will run on the machine. All agents on the machine will run as this service. The 
user account must have appropriate privileges as described in "Specifying credentials for Acronis 
services" (p. 23). Separate the name of the domain and the account by a backslash, as in: 
mydomain\User. 
Without this parameter, the service will run under the default account: Acronis Agent User 

/remote_users <User1>;<User2>;…;<UserN> 

Specifies the user names that will be added to the Acronis Remote Users group. Members of this 
group are allowed to connect to the machine remotely. 
With this parameter, only the specified users will be added to the group. Separate the user 
names by using semicolons (;). 
Without this parameter, all members of the Administrators group on the particular machine will 
be added to the group. 

/ams_address <Management server> 

Specifies the name or IP address of Acronis Backup & Recovery 11.5 Management Server. With 
this parameter, the machine will be registered on the management server after the installation is 
complete. 
/ams_user <Administrator name> <Password> 

Specifies the name and password of a user who is a member of the Acronis Centralized 
Admins group on the management server. Use this parameter with the /ams_address 
parameter. 

Parameters that apply only to a component that requires a license 

The following parameters apply only to the installation packages AcronisAgentWindows.msi, 
AcronisAgentESX.msi, AcronisAgentHyperV.msi, AcronisUniversalRestore.msi (except the 
/online_backup and /advanced_online_backup parameters), and 
AcronisDeduplication.msi (except the /online_backup and /advanced_online_backup 
parameters). 

/serial <License key> 

Specifies the license key to use when installing the component. A license key is a sequence of 
letters and numerals separated by dashes. Enter the license key exactly, including the dashes. 
/old_serial <old license key> 
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When upgrading from Acronis Backup & Recovery 10 or 11, this parameter specifies the 
license key for that product. Use this parameter with the /serial parameter. 

If the license keys are stored on a license server, use the /license_server parameter 
instead. 

/license_server <License server> 

Specifies the name or IP address of the machine where the license server is installed. 
When using this parameter, also specify the /product parameter. 
/product <Edition code> 

Specifies the code of your edition of Acronis Backup & Recovery 11.5. 
The codes are the following: 
Acronis Backup & Recovery 11.5 Advanced Server: ABR11.5_AS 
Acronis Backup & Recovery 11.5 Advanced Server for Windows: ABR11.5_ASW 
Acronis Backup & Recovery 11.5 Advanced Server SBS Edition: ABR11.5_SBS 
Acronis Backup & Recovery 11.5 Advanced Workstation: ABR11.5_AW 
Acronis Backup & Recovery 11.5 Virtual Edition family: ABR11.5_VE, ABR11.5_VEESX, 
ABR11.5_VEHV, ABR11.5_VERHEV, ABR11.5_VEXEN, ABR11.5_VEPRL, or ABR11.5_VEORCL 
Acronis Backup & Recovery 11.5 Microsoft SQL Server Add-On: ABR11.5_SQLADD or 
ABR11.5_SPADD 
Acronis Backup & Recovery 11.5 Microsoft Active Directory Add-On: ABR11.5_ADADD. 

/online_backup 

Specifies that the component will be installed for online backup only and will have local 
management capability. Neither license key nor license server is required. 

/advanced_online_backup 

Specifies that the component will be installed for online backup only and will have local, 
centralized, and remote management capability. Neither license key nor license server is 
required. 

Parameter that applies only to the Management Console component 

The following parameter applies only to the installation package AcronisManagementConsole.msi. 

/current_user 

Specifies that the component will be installed for the current user only and not for all users on a 
machine. 
Avoid using this parameter when installing the component through Group Policy, because the 
“current user” in such installation is typically a system account. 

 

2.1.5 Installation from the management server Web page 
Acronis Backup & Recovery 11.5 Management Server comes with its own Web server and Web page. 
You or users in your organization can go to that Web page from any machine with a supported Web 
browser (p. 36), and install Acronis Backup & Recovery 11.5 without having to specify installation 
settings. When installing an agent, the setup program registers the machine on the management 
server. 

The Web page enables access to installation packages in a network that does not allow sharing 
folders. 
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Unlike installation through Group Policy (p. 30), installation from the Web page can be started by the 
user. It can be performed on machines that are not members of a domain, including machines 
running Linux.* 

Unlike remote installation (p. 47), which is often blocked by a firewall, installation from the Web 
page does not require any non-standard network ports to be open. A port for HTTP (by default, port 
8080) is used for installation. 

For the Web page to work, the Components for Remote Installation component must be installed. 
When installing the management server, check the summary page to make sure that this component 
is among the components to install. You can specify the folder where to place the installation 
packages. 

*To add a component for Linux to the Web page, download this component from the Acronis Web site. Then 
add the corresponding installed-products element to the configuration file described in "Changing 
installation settings" (p. 37). This will make the component's installation file accessible via the Web page. Other 
settings of the configuration file will be ignored in Linux. You need to specify installation settings manually 
during every installation. 
 

2.1.5.1 Supported Web browsers 
The Web page can be accessed from any of these Web browsers: 

 Internet Explorer 6 or later 
 Mozilla Firefox 3.6 or later 
 Safari 5 or later 
 Google Chrome 6 or later 
 Opera 10.6 or later 
Important: Make sure that JavaScript is enabled in the browser. 
 

2.1.5.2 Using the management server Web page 
To open the management server Web page, type the name or IP address of the management server’s 
machine and the port number in the browser’s address bar. For example, type http://ams:8080 or 
http://192.168.0.1:8080 

If the Web page must be accessed through a non-default port, specify that port instead of 8080. 

Installation with pre-selected components 
The following is how you can use the Web page to enable users in your organization to easily install 
Acronis Backup & Recovery 11.5 on their machines: 

1. You go to the Web page. It displays the list of components of Acronis Backup & Recovery 11.5 
that a user can install. 

2. You select one or more components that the users need to install. 
3. You copy the Download link and send it to the users. 
4. A user follows the link and starts the setup program. 
5. The setup program runs with all required fields (such as the name of the license server) already 

filled in. The user can go through the installation wizard without changing any settings. 
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Installation with selecting components on-site 
The following is how advanced users can use the Web page to easily install Acronis Backup & 
Recovery 11.5 on their machines: 

1. A user goes to the Web page. It displays the list of components of Acronis Backup & Recovery 
11.5 that the user can install. 

2. The user selects one or more components to install. 
3. The user clicks the Download button. 
4. The user starts the setup program. 
5. The setup program runs with all required fields (such as the name of the license server) already 

filled in. The user can go through the installation wizard and change any settings if necessary. 

How installation works 
The setup program itself is small in size. It downloads the installation packages of the selected 
components from the management server’s machine. 

When installing an agent in Windows, the setup program will create a dedicated user account for the 
agent’s service. 
 

2.1.5.3 Default installation settings 
The setup program takes installation settings from the configuration file, which is stored on the 
management server’s machine. 

The default settings in the configuration file are the following: 

 To use the license server that comes with the management server. Each agent and each feature 
(such as Deduplication) being installed will acquire its own license from that license server. 

 To install the components to the following folder: 
 In 32-bit versions of Windows: %ProgramFiles%\Acronis 
 In 64-bit versions of Windows: %ProgramFiles(x86)%\Acronis 
 In Linux: /usr/lib/Acronis (this setting cannot be changed) 

For information about how to change the default settings, see "Changing installation settings" (p. 
37). 
 

2.1.5.4 Changing installation settings 
To change the default installation settings, you need to edit the configuration file. 

The name of the configuration file is settings.xml. The file is stored on the machine where the 
management server is installed. The file is located in the WebPage subfolder of the installation folder 
you specified. By default: 

 When installed in a 32-bit version of Windows: %ProgramFiles%\Acronis\WebPage 
 When installed in a 64-bit version of Windows: %ProgramFiles(x86)%\Acronis\WebPage 

This file stores settings in the following elements: 

installed-products 

Specifies what components appear on the Web page. Each component is specified as a 
product element. For example: 
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<product 
    name="Agent for Windows" 
    package="AcronisAgentWindows.msi" 
    type="win" 
    description="Install the agent on a machine to be able to back up its disks, 
volumes and files." 
/>  

The product element has the following attributes: 
name 

The name of the component as it appears on the Web page. 
package 

The name of the component’s installation package (an .msi, .i686, or .x86_64 file). The file 
must be located in the following folder: 
%CommonProgramFiles%\Acronis\RemoteInstaller\<product build 
number>. 

type 
The operating system for which the component is intended. The possible values of this 
attribute: win (Windows) and linux (Linux). 

description 
The description of the component as it appears on the Web page. The description is shown 
under the name of the component. 

ams 

Specifies the management server (AMS) on which the machine will be registered after 
installation. For example: 
<ams address="ManagementServer" /> 

The address attribute specifies the name or IP address of the management server. 
This must be the same server where the Web page is installed. Do not try to specify another 
server here. However, you can change the network name of the server to its fully-qualified 
domain name (FQDN), such as ManagementServer.example.com, or to its IP address. This may be 
useful if the downloaded setup program fails to add user machines to the management server. 

license-server 

Specifies the license server from which components will take licenses during installation. For 
example: 
<license-server address="LicenseServer" /> 

The address attribute specifies the name or IP address of the license server. 

web-setup-settings 

Specifies how the components will be installed. 
This element has the following content: 
acep 

Specifies whether to enable the machine to participate in the Acronis Customer Experience 
Program (CEP). The default setting is: 
<acep enabled="false" /> 

The possible values of the enabled attribute: true (participation is enabled) and false 
(participation is not enabled). 
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install 

Specifies for which Windows users to install the components and how much interaction is 
required from the user during installation. The default setting is: 
<install for_user="all" mode="manual" />  

The possible values of the for_user attribute: all (to install the components for all Windows 
users on the machine) and current (to install the components only for the Windows user who 
started the setup program). 
The mode attribute is reserved for use in future versions. Its only possible value now is 
manual. With this value, the setup program runs will all required fields already filled in, but 
the user still must go through the installation wizard. 

installation-path 
Specifies where to install the components. 
This element has the following content: 
x86 
Specifies where to install the components on machines running 32-bit versions of Windows. 
x64 
Specifies where to install the components on machines running 64-bit versions of Windows. 
In both elements, the path attribute specifies the path. The default settings are: 
<x86 path="%ProgramFiles%/Acronis" />  

<x64 path="%ProgramFiles(x86)%/Acronis" /> 

Components for Linux are always installed to the /usr/lib/Acronis directory. 
 

2.1.5.5 Changing the port for the Web page 
By default, the Web page is available through port 8080. If another program already uses this port, 
you will need to specify a different port. 

The port number is shown on the summary screen when you install the management server. To be 
able to change the port number, select the I want to manually select the Acronis components… 
check box in the machine role selection window. Then, specify the port in the corresponding window. 

If the management server is already installed, you can change the port number by reconfiguring the 
Web server, as follows: 

1. Open the httpd.conf file, which is located in the following folder: 
 In a 32-bit version of Windows: %CommonProgramFiles%\Acronis\WebServer\conf 
 In a 64-bit version of Windows: %CommonProgramFiles(x86)%\Acronis\WebServer\conf 

2. Change the value of the Listen setting to the desired port number. For example, the setting 
Listen 8888 means using port 8888 for the Web page. 
Important: Do not specify the port through which the management server communicates with other 
components of Acronis Backup & Recovery 11.5. By default, this is port 9876. 

3. Restart the service of the Web server. You can do this in either of these ways: 
 At the command prompt by running the following commands: 

net stop "Acronis Web Server Service" 
net start "Acronis Web Server Service" 

 In the Services snap-in by right-clicking Acronis Web Server Service and then clicking Restart. 
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2.1.6 Installing Acronis License Server 
The license server is integrated with Acronis Backup & Recovery 11.5 Management Server. We 
recommend using that license server. 

If you need to install the license server as a separate component, use the following procedure. 

To install the license server as a separate component 
1. Start the setup program. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Accept the terms of the license agreement. 
4. Select the I want to manually select the Acronis components… check box, and then click Next. 
5. In the list of components, under Other components, select the License Server check box, and 

then click Next. 
Click Import from file and specify the file containing the list of license keys. You can specify 
multiple files one by one or enter the license keys manually. 
Details. You will be able to import additional license keys later at any moment (including when 
installing the agents), by specifying a file containing the keys or by typing them in manually. 

6. Use the default values for Install to: and Install for: 
7. Proceed with installation. 
 

2.2 Installation in Linux 
This section describes installation of Acronis Backup & Recovery 11.5 components on a machine 
running Linux. 

By using command-line parameters, you can install the product in the unattended installation mode. 
 

2.2.1 Preparation 
This section describes preparatory steps for installation in Linux. 
 

2.2.1.1 RPM Package Manager 
Make sure that the RPM Package Manager (RPM) is installed in your system. Before installing the 
product on a Linux distribution that does not use RPM, such as Ubuntu, you need to install RPM 
manually; for example, by running the following command: 

sudo apt-get install rpm 

Linux distributions where RPM is already installed include Red Hat Enterprise Linux, Fedora, and SUSE 
Linux Enterprise Server. 
 

2.2.1.2 Linux packages 
To add the Acronis Backup & Recovery 11.5 modules to the Linux kernel, the setup program needs 
the following Linux packages: 

 The package for building kernel modules. The package version must match the kernel version. 
 The GNU Compiler Collection (GCC) compiler system. The GCC version must be the one with 

which the kernel was compiled. 
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 The Make tool. 

The names of these packages vary depending on your Linux distribution. 

In Red Hat Enterprise Linux and CentOS, the packages normally will be installed by the setup 
program. In other distributions, you need to install the packages if they are not installed or do not 
have the required versions. 

Are the required packages already installed? 
To check whether the packages are already installed, perform these steps: 

1. Run the following command to find out the kernel version and the required GCC version: 
cat /proc/version 

This command returns lines similar to the following: Linux version 2.6.35.6 and gcc 
version 4.5.1 

2. Run the following command to check whether the Make tool and the GCC compiler are installed: 
make -v 
gcc -v 

For gcc, ensure that the version returned by the command is the same as in the gcc version in 
step 1. For make, just ensure that the command runs. 

3. Check whether the appropriate version of the packages for building kernel modules is installed: 
 In Red Hat Enterprise Linux, CentOS, and Fedora, run the following command: 

yum list installed | grep kernel-devel 

 In Ubuntu, run the following commands: 
dpkg --get-selections | grep linux-headers 
dpkg --get-selections | grep linux-image 

In either case, ensure that the package versions are the same as in Linux version in step 1. 

Installing the packages from the repository 
The following table lists how to install the required packages in various Linux distributions. 

Linux 
distribution 

Package names How to install 

Red Hat 
Enterprise 
Linux 

kernel-devel 
gcc 
make 

The setup program will download and install the packages 
automatically by using your Red Hat subscription. 

CentOS kernel-devel 
gcc 
make 

The setup program will download and install the packages 
automatically. 

Fedora kernel-devel 
gcc 
make 

Run the following commands as the root user (specify the required 
GCC version in the GCC package name): 

yum install kernel-devel-`uname -r` 
yum install gcc-4.5.1 
yum install make 
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Ubuntu linux-headers 
linux-image 
gcc 
make 

Run the following commands (specify the required GCC version in the 
GCC package name): 

sudo apt-get update 
sudo apt-get install linux-headers-`uname -r` 
sudo apt-get install linux-image-`uname -r` 
sudo apt-get install gcc-4.6 
sudo apt-get install make 

The packages will be downloaded from the distribution's repository and installed.  

For other Linux distributions, please refer to the distribution's documentation regarding the exact 
names of the required packages and the ways to install them. 

Installing the packages manually 
You may need to install the packages manually if: 

 The machine does not have an active Red Hat subscription or Internet connection. 
 The setup program cannot find the kernel-devel or gcc version corresponding to the kernel 

version. If the available kernel-devel is more recent than your kernel, you need to either update 
the kernel or install the matching kernel-devel version manually. 

 You have the required packages on the local network and do not want to spend time for 
automatic search and downloading. 

Obtain the packages from your local network or a trusted third-party Web site, and install them as 
follows: 

 In Red Hat Enterprise Linux, CentOS, or Fedora, run the following command as the root user: 
rpm -ivh PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3 

 In Ubuntu, run the following command: 
sudo dpkg -i PACKAGE_FILE1 PACKAGE_FILE2 PACKAGE_FILE3 

Example: Installing the packages manually in Fedora 14 

Follow these steps to install the required packages in Fedora 14 on a 32-bit machine: 

1. Run the following command to determine the kernel version and the required GCC version: 
cat /proc/version 

The output of this command includes the following: 
Linux version 2.6.35.6-45.fc14.i686 
gcc version 4.5.1 

2. Obtain the kernel-devel and gcc packages that correspond to this kernel version: 
kernel-devel-2.6.35.6-45.fc14.i686.rpm 
gcc-4.5.1-4.fc14.i686.rpm 

3. Obtain the make package for Fedora 14: 
make-3.82-3.fc14.i686 

4. Install the packages by running the following commands as the root user: 
rpm -ivh kernel-devel-2.6.35.6-45.fc14.i686.rpm 
rpm -ivh gcc-4.5.1.fc14.i686.rpm 
rpm -ivh make-3.82-3.fc14.i686 
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You can specify all these packages in a single rpm command. Installing any of these packages 
may require installing additional packages to resolve dependencies. 

 

2.2.1.3 Installation files 
Download the installation files and assign them necessary access permissions: 

1. Go to the Acronis Web site. 
2. Depending on the machine platform and your edition of Acronis Backup & Recovery 11.5, 

download the installation file or files (.i686 or .x86_64 files). 
3. Copy the installation files to a directory on the machine where you want to install Acronis Backup 

& Recovery 11.5. 
4. Go to the directory where you copied the installation files, and then run the following command: 

chmod 755 ABR11* 
 

2.2.2 Interactive installation in advanced editions 
To install Acronis Backup & Recovery 11.5 Agent for Linux 
1. Ensure that you have the licenses for Acronis Backup & Recovery 11.5 and (optionally) Universal 

Restore and/or Deduplication. You can import the licenses to the Acronis License Server. 
To install the agent in the trial mode (p. 4), you do not need licenses. 

2. Run the appropriate installation file (an .i686 or an .x86_64 file) as the root user. 
3. Accept the terms of the license agreement. 
4. Specify the license keys in either of these ways or select to install the agent in the trial mode: 
 Type the name or IP address of the license server. If the license server contains licenses for 

additional features, such as Universal Restore, specify whether you want to install these 
features. 

 Type your Acronis Backup & Recovery 11.5 license key. Likewise, you can add license keys for 
Universal Restore and/or Deduplication. 

5. Specify whether you want to register the machine on the management server. You can add the 
machine to the management server later by using the machine's name or IP address. 

6. If you install the software in Red Hat Enterprise Linux or CentOS, the setup program may notify 
you about the absence of some of the required Linux packages. Select Continue to try to install 
these packages automatically (recommended), or select Skip to skip the package installation. For 
more detailed information about the required packages, see the "Linux packages" (p. 40) section. 

7. The setup program tries to automatically compile the SnapAPI module for your Linux kernel. If it 
fails to do so, please refer to the file: /usr/lib/Acronis/BackupAndRecovery/HOWTO.INSTALL. 

To install Acronis Backup & Recovery 11.5 Management Console or Acronis Bootable Media 
Builder 
1. Run the installation file of the management console or bootable media builder (an .i686 or an 

.x86_64 file) as the root user. 
2. Follow the on-screen instructions. 
 

2.2.3 Installation in the unattended mode 
To install a component in the unattended mode (without asking for confirmations), run the 
component’s installation file with the -a command-line parameter. You may need to use other 
parameters (p. 44) to specify how to perform the installation. 
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The following are two examples of unattended installation. Both examples assume that the name of 
the installation file is ABR11AgentLinux.i686. 

Example 1: Unattended installation with a license key. This example applies to all editions of Acronis 
Backup & Recovery 11.5. 

The following command installs Acronis Backup & Recovery 11.5 Agent for Linux in the unattended 
mode (without asking for confirmations) and uses the license key 12345-67890-ABCDE: 

./ABR11AgentLinux.i686 -a -i BackupAndRecoveryAgent -l 12345-67890-ABCDE 

Example 2: Unattended installation with a license server. This example applies only to advanced 
editions of Acronis Backup & Recovery 11.5. 

The following command: 

 Installs Acronis Backup & Recovery 11.5 Agent for Linux in the unattended mode. 
 Uses Acronis License Server located on the machine licensesrv, and a license key for the Acronis 

Backup & Recovery 11.5 Advanced Server edition. 
 Registers the machine on Acronis Backup & Recovery 11.5 Management Server located on the 

machine managementsrv once the installation is complete. 

./ABR11AgentLinux.i686 -a -i BackupAndRecoveryAgent -L licensesrv -P AS -C managementsrv 
-g srvadmin -w PassWd123 
 

2.2.4 Command-line parameters 
When running the installation files of Acronis Backup & Recovery 11.5, you can specify one or more 
of command-line parameters. 

Parameters 
Unless stated otherwise, the parameters are present in all installation files. 

-a or --auto 

Performs installation in the so-called unattended setup mode, as opposed to the default 
interactive mode. 
The setup program will proceed without asking for interaction, such as typing the license key or 
clicking the Next buttons. 
When using this parameter, you need to specify the component to install, by using the -i 
parameter. 
When running the installation file of Acronis Backup & Recovery 11.5 Agent for Linux, you also 
need to specify the license server or the license key by using the -L or -l parameter, 
respectively. 
If the SnapAPI module needs to be compiled and the compilation is possible, the setup program 
will automatically compile the module; otherwise, it will skip the compilation. 

-n or --nodeps 

Ignores dependencies during an unattended setup. This option is effective only in the 
unattended setup mode (see the -a parameter described previously). 

-u or --uninstall 

Uninstalls the component. You do not need to specify a license key or the license server. 
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-s or --disable-native-shared 

Forces using the setup program’s own redistributable libraries during installation, instead of 
those present in the system. 
Redistributable libraries are standard sets of internal tools. Programs use these libraries for 
purposes such as displaying the user interface. 
The setup program contains copies of all the libraries it needs. By default, it uses a copy of a 
library only when no such library is present in the system. With this parameter, the setup 
program always uses the copy. 
You may want to use this parameter when experiencing problems with installation; for example, 
when the user interface of the setup program is not displayed correctly. 

-d or --debug 

Puts verbose information to the installation log.  

-i <Component name> or --id=<Component name> 

You do not have to specify this parameter in advanced editions. It is present for uniformity with 
the command-line parameters of the installation file of Acronis Backup & Recovery 11.5 Server for 
Linux. 
Specifies the name of the component being installed: 

For Acronis Backup & Recovery 11.5 Agent for Linux: BackupAndRecoveryAgent 
For Acronis Backup & Recovery 11.5 Bootable Components and Media Builder: 
BackupAndRecoveryBootableComponents 
For Acronis Backup & Recovery 11.5 Management Console: ManagementConsole 

The names are case-sensitive. 

-e {0|1} or --ssl={0|1} 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies whether to enable authentication for connection to other components. Authentication 
is performed by using Secure Socket Layer (SSL) certificates. 
The possible values are: 

0: Do not use authentication 
1: Use authentication 

-C <Management server> or --ams=<Management server> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the name or IP address of the Acronis Backup & Recovery 11.5 Management Server. 
When using this parameter, you need to specify the user name and password of a management 
server administrator by using the -g and -w parameters, respectively. 
The machine will be registered on the management server after the installation is complete. 

-g <User name> or --login=<User name> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the user name of a member of the Acronis Centralized Admins group on the 
management server whose name is given by <Management server>. 

-w <Password> or --password=<Password> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
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Specifies the password for the user whose name is given by <User name>. 

-p <Port number> or --port=<Port number> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the number of the TCP port to use to connect to other Acronis Backup & Recovery 11.5 
components. The default port number is 9876. 

--aur 

Applies only to the installation files of Acronis Backup & Recovery 11.5 Agent for Linux and 
Acronis Backup & Recovery 11.5 Bootable Components and Media Builder. 
Enables the Universal Restore feature. You need to specify a license key for this feature, by using 
the -l or -L parameter (see later in this section). 
Note: This feature is already enabled in Acronis Backup & Recovery 11.5 Virtual Edition. 

--dedup 

Applies only to the installation files of Acronis Backup & Recovery 11.5 Agent for Linux and 
Acronis Backup & Recovery 11.5 Bootable Components and Media Builder. 
Enables the Deduplication feature. You need to specify a license key for this feature, by using the 
-l or the -L parameter (see later in this section). 
Note: This feature is already enabled in the trial mode of Acronis Backup & Recovery 11.5. 

-l <License key> or --serial=<License key> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the license key for the component. Use either this parameter or the -L parameter. 
If you are enabling the Deduplication and/or the Universal Restore feature (see the --aur and 
--dedup parameters described previously), also specify the corresponding license keys, 
separating them by commas; for example: 
-l 11111-AAAAA,22222-DDDDD,33333-UUUUU 

-L <License server> or --license-server=<License server> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the name or IP address of the Acronis License Server. Use either this parameter or the 
-l parameter. 
When using this parameter, you need to specify the code of your edition of Acronis Backup & 
Recovery 11.5, by using the -P parameter. 

-P <Product alias> 

Applies only to the installation file of Acronis Backup & Recovery 11.5 Agent for Linux. 
Specifies the code of your edition of Acronis Backup & Recovery 11.5—also called the product 
alias. The codes are the following: 

Acronis Backup & Recovery 11.5 Advanced Server: ABR11.5_AS 
Acronis Backup & Recovery 11.5 Advanced Server for Linux: ABR11.5_ASL 
Acronis Backup & Recovery 11.5 Virtual Edition family: ABR11.5_VE, ABR11.5_VEESX, 
ABR11.5_VEHV, ABR11.5_VERHEV, ABR11.5_VEXEN, or ABR11.5_VEPRL 

-v or --version 

Displays the product version and then exits. 

-? or --help 
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Displays help and then exits. 

--usage 

Displays a brief usage message and then exits. 
 

2.3 Remote installation 
Components of Acronis Backup & Recovery 11.5, such as Agent for Windows and Agent for Linux, can 
be installed remotely to one or more machines running the corresponding operating systems. 

To perform remote installation, you need administrative privileges on the target machines. 

You can perform remote installation in any of these ways: 

 From the management console installed on a machine running Windows. 
 When adding one or more machines to the management server. 
 

2.3.1 Prerequisites 
Management console 
You need the management console installed on a machine running Windows. 

Installation packages 
Components are installed from installation packages. By default, the software takes these packages 
from the folder %CommonProgramFiles%\Acronis\RemoteInstaller\<product 
build number>. If the console is connected to the management server, the software will take the 
packages from the machine with the management server. Otherwise, the software will take the 
packages from the machine with the console. 

If the installation packages are not present in this folder (or in another folder that you will be able to 
specify during the installation), get them as follows. 

How to get packages for Windows 
1. Start the Acronis Backup & Recovery 11.5 setup program on the machine from which the 

packages are to be taken by the software. The setup file must be in a local folder. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Accept the terms of the license agreement. 
4. Click Modify. 
5. Select the Components for Remote Installation check box and click Next. 
6. Follow the on-screen instructions. 

How to get packages for Linux 

Download the required installation files (.i686 or .x86_64) from the Acronis Web site and put them 
on the machine from which they are to be taken by the software. 

If you are planning to install Acronis components on both Windows and Linux machines, put the 
packages for Linux into the directory where the packages for Windows are. This will help you 
configure installation of Acronis components on Windows and Linux machines at the same time. 
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2.3.2 Preparation 
On machines running Windows 
1. Make sure that the machines meet the system requirements (p. 16). 
2. For successful installation on a remote machine running Windows XP or later, the option Control 

panel > Folder options > View > Use simple file sharing (for Windows XP) or Control panel > 
Folder options > View > Use Sharing Wizard (in Windows Vista or later) must be disabled on that 
machine. 

3. For successful installation on a remote machine that is not a member of an Active Directory 
domain, User Account Control (UAC) must be disabled (p. 48). 

4. File and Printer Sharing must be enabled on the remote machine. To access this option: 
 On a machine running Windows XP with Service Pack 2 or Windows 2003 Server: go to 

Control panel > Windows Firewall > Exceptions > File and Printer Sharing. 
 On a machine running Windows Vista, Windows Server 2008, or Windows 7: go to Control 

panel > Windows Firewall > Network and Sharing Center > Change advanced sharing 
settings. 

5. Acronis Backup & Recovery 11.5 uses TCP ports 445 and 25001 for remote installation. Also, it 
uses TCP port 9876 for remote installation and for communication between the components.  
Port 445 is automatically opened when you enable File and Printer Sharing. Ports 9876 and 
25001 are automatically opened through Windows Firewall. If you use a different firewall, make 
sure that these three ports are open (added to exceptions) for both incoming and outgoing 
requests. 
After the remote installation is complete, you can remove ports 445 and 25001 from exceptions. 
Port 25001 is automatically closed through Windows Firewall. Port 9876 needs to remain open. 

On machines running Linux 
1. Make sure that the machines meet the system requirements (p. 16). 
2. Check that each of the machines meets the prerequisites for local installation of Agent for Linux 

(p. 40), except for the "Installation files" step. 
3. Make sure that TCP port 22 is opened and that the SSH daemon is running on each of the 

machines. After the remote installation is complete, you can close the port and stop the SSH 
daemon. 

4. Open TCP port 9876 on each of the machines. Acronis Backup & Recovery 11.5 uses this port for 
communication between the components; therefore, it must remain open for both incoming and 
outgoing requests. 

 

2.3.2.1 Requirements on User Account Control (UAC) 
On a machine that is running Windows Vista or later and is not a member of an Active Directory 
domain, centralized management operations (including remote installation) require that UAC be 
disabled. 

To disable UAC 

Do one of the following depending on the operating system: 

 In a Windows operating system prior to Windows 8: 
Go to Control panel > View by: Small icons > User Accounts > Change User Account Control 
Settings, and then move the slider to Never notify. Then, restart the machine. 
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 In any Windows operating system, including Windows 8/8.1 and Windows Server 2012/2012 R2: 

1. Open Registry Editor. 
2. Locate the following registry key: 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\System 
3. For the EnableLUA value, change the setting to 0. 
4. Restart the machine. 

 

2.3.3 Installation procedure 
Do the following to install components of Acronis Backup & Recovery 11.5 remotely: 

1. Start the remote installation in any of these ways: 
 From the management console: Start the management console. On the Tools menu, click 

Install Acronis components. 
 When adding one or more machines to the management server: Connect the management 

console to the management server. On the Actions menu, click Add a machine to AMS or 
Add multiple machines. 

2. Specify the machines where the components are to be installed (p. 49). When adding a single 
machine to the management server, just specify that machine's name or IP address, and the 
credentials of an account with administrative privileges on that machine. 

3. Specify the components that you want to install (p. 50). Please keep in mind that the component 
features, such as Deduplication, cannot be installed if the main component is not installed or 
selected for installation. 

4. If prompted, specify one or more of the following parameters depending on your component 
selection: 
 Installation mode (with or without license keys) (p. 51). 
 Installation options: 
 Credentials for the agent service (p. 23). By default, the setup program will create a 

dedicated user account for the service. 
 Whether to allow the restart of the remote machine. 

 Whether to register the machines on the management server. 
 Whether the machines will participate in Acronis Customer Experience Program (CEP). 

5. On the summary page, review the list of machines where the components will be installed, the 
components that will be installed, and the installation settings for those components. Click 
Proceed to start the installation. 

Once the installation starts, the program displays the names of the machines on which the 
components are being installed. 

Update 
To update one or more components on a remote machine, repeat the installation procedure. 
 

2.3.3.1 Specifying the list of machines 
When adding multiple machines to the management server or when performing remote installation, 
you need to specify the list of machines. 



50 Copyright © Acronis International GmbH, 2002-2013. 

 

 

Adding machines 
Use one or more of the following options to add machines to the list: 

By IP/name Type a machine name or IP address and specify the credentials of an account with 
administrative privileges on it. 

From network Specify machines by browsing the network. You can select individual machines, as well as 
entire workgroups or domains.  

From Active 
Directory 

Specify machines by browsing an Active Directory domain.  

This option is available only if the machine with the management console is a member of 
that domain. 

From file Import the list of the machines from a .txt or .csv file. The file should contain machine 
names or IP addresses and they should be one machine per line.  

Example: 

Machine_name_1 
Machine_name_2 
192.168.1.14 
192.168.1.15 

From RHEV 
environment 

Specify machines by connecting to a Red Hat Enterprise Virtualization Manager. Provide 
the credentials of the account with the access rights on the RHEV Manager. Be sure to also 
specify the domain name (DOMAIN\Username or Username@domain).  

From the list of RHEV machines, select the machines you want to add. 

By application Specify machines on which certain applications are installed. Use the Servers and clusters 
found filter to show the machines that have an application you need to back up. 

This option is available only when adding machines to the management server. The 
management server must be a member of a domain, and you can only select machines 
from that domain. 

Specifying credentials 
For each of the machines, specify the credentials of an account with administrative privileges on that 
machine. Or you can specify a universal account that has administrative privileges on all of the 
machines. Enter the account credentials for one machine and click Apply to all machines.  

Note. For a machine which is a domain controller in an Active Directory domain, you must specify the name of 
that domain together with the user name. For example: MyDomain\Administrator 

Detecting agents 
Once you specify the machines to add to the management server, Acronis Backup & Recovery 11.5 
detects the machines on which agents are not yet installed. We recommend that you wait until the 
detection is complete.  

To cancel the detection, click Cancel status detection. In this case, agents will be installed only on the 
machines where the detection was completed. Of the machines where the detection was canceled, 
only the machines with an agent already installed will be added to the management server. 
 

2.3.3.2 Specifying the components for remote installation 
By default, the software takes the installation packages from the folder 
%CommonProgramFiles%\Acronis\RemoteInstaller\<product build number>. If 
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the console is connected to the management server, the software will take the packages from the 
machine with the management server. Otherwise, the software will take the packages from the 
machine with the console. 

To take the packages from a different location, click Change components source. You have the 
following options: 

 From the registered components. The default location. 
 On removable media. The software will search for the installation packages on removable media 

such as CD, DVD, BD, or USB flash drive. 
 In the following location. Specify a local or network folder where you extracted the installation 

packages. If prompted for credentials, specify the user name and password. 

For more information about how to get the installation packages, refer to "Prerequisites" (p. 47). 

Components that cannot be installed remotely 
You cannot install the following components by using remote installation: 

 Acronis Backup & Recovery 11.5 Agent for Microsoft Exchange Server 
 Acronis Backup & Recovery 11.5 Agent for Microsoft SQL Server (single-pass) 
 Acronis Backup & Recovery 11.5 Agent for Microsoft Active Directory (single-pass) 
 Acronis Backup & Recovery 11.5 Agent for VMware vSphere ESX(i) (Windows) 
 Acronis Backup & Recovery 11.5 Management Server 
 Acronis Backup & Recovery 11.5 Storage Node 
 Acronis Backup & Recovery 11.5 Components for Remote Installation 
 Acronis PXE Server 
 Acronis License Server 
 

2.3.3.3 Installation with or without license keys 
When installing agents, you need to provide license keys or choose installation without license keys. 

Installing without license keys 
Select Install in trial mode or for online backup only. 

The agents will be installed in the trial mode (p. 4). 

Online backup will be available on machines running Windows after you activate a subscription to 
the online backup service on each machine. Online backup will be available until the subscription 
period expires. 

Please do not try to import the subscription keys to Acronis License Server or type them in the installation wizard 
windows. 

Specifying license keys 
Select one of the following: 

 Specify license keys manually. You will be able to type the license keys or import them from a 
text file. 
When you add machines to the management server, this option is not available. 
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 Use licenses from the following license server. Specify the name or IP address of the license 

server or the management server and provide access credentials for the server. 
When you add machines to the management server, the software automatically selects the 
license server used by the management server. You cannot change it. 

After you click Next, the software automatically assigns the available licenses to the components. 

Viewing and changing the assignment of licenses 
The Licensing window shows how many licenses are required and the number of deficient licenses. 

To add one or more licenses, click Add license. You will be able to type the license keys or import 
them from a text file. 

To view or change the assignment of licenses, click View license mapping. In the License Mapping 
window, you can set up which component will use which license, as follows: 

1. Click a machine in the Machines list. 
2. Under Components, examine which components on the machine require licenses. 
3. Under Used Licenses, assign or reassign the licenses for these components by selecting or 

clearing the corresponding check boxes. 
 

2.4 Installation of Agent for ESX(i) 
Agent for ESX(i) enables backup and recovery of ESX(i) virtual machines without installing agents into 
the guest systems. 

The agent is delivered in two versions: 

 Agent for ESX(i) (Virtual Appliance) can be imported or deployed to a VMware ESX(i) host. 
 For off-loaded backup, Agent for ESX(i) (Windows) can be installed on a machine running 

Windows. 

Preparation 
We highly recommend that you install Acronis Backup & Recovery 11.5 Management Server prior to 
the Agent for ESX(i) installation. During the agent installation, specify the management server each 
time you are asked to register the agent or prompted for a license server (unless you chose to use a 
separately installed license server). 

Agent for ESX(i) (Virtual Appliance) 
There are three methods of installing Agent for ESX(i) (Virtual Appliance): 

 Importing (p. 54) to a ESX(i) host as an OVF template. 
Use this method for troubleshooting purposes or if you cannot install Acronis Backup & Recovery 
11.5 Management Server for some reason. 

 Deployment from Acronis Backup & Recovery 11.5 Management Server to a specified host or 
cluster. 
Connect the console to the management server. In the Navigation tree, right click Virtual 
machines, then click Deploy Agent for ESX(i). Refer to the context help for further instructions. 

 Automatic deployment from Acronis Backup & Recovery 11.5 Management Server.  
This is the easiest method. It is recommended in most cases. Connect the console to the 
management server. In the Navigation tree, right click Virtual machines, and then click Configure 
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VMware vCenter integration. Specify the vCenter Server, and then enable Automatic 
deployment. Any time a virtual machine is selected for backup but the agent is not installed on 
its host, the Virtual Appliance will be automatically deployed on the host when the backup starts. 

Agent for ESX(i) (Windows) 
If your production ESX(i) hosts are so heavily loaded that running the virtual appliances is not 
desirable, consider installing Agent for ESX(i) (Windows) on a physical machine outside the ESX 
infrastructure. 

If your ESX(i) uses a SAN attached storage, install the agent on a machine connected to the same 
SAN. The agent will back up the virtual machines directly from the storage rather than via the ESX(i) 
host and LAN. This capability is called a LAN-free backup.  

The diagram below illustrates a LAN-based and a LAN-free backup. LAN-free access to virtual 
machines is available if you have a fibre channel (FC) or iSCSI Storage Area Network. To completely 
eliminate transferring the backed-up data via LAN, store the backups on a local disk of the agent's 
machine or on a SAN attached storage. 

 

Agent for ESX(i) (Windows) can be installed on any machine that runs Windows and meets the 
system requirements (p. 16). Follow the instructions described in the "Interactive installation in 
advanced editions" (p. 20) section. 

During installation, specify the vCenter Server or ESX(i) Server whose virtual machines the agent will 
back up.  
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You will be able to set or change this setting at a later time. To access this setting after the agent has 
been installed, connect the console to the machine with the agent and select from the top menu 
Options > Machine options > Agent for VMware vSphere ESX(i) (Windows). 

Providing licenses 
The installation of Agent for VMware vSphere ESX(i) (both versions) does not require a license. 
However, you must specify a license server. Once the agent starts backing up a virtual machine, the 
agent checks whether the virtual machine's host has a license. If it does not have one, the agent 
takes a free license from the specified license server and assigns it to the host. If the host is included 
in a cluster, licenses will be assigned to all of the clustered hosts. Therefore, you need one Virtual 
Edition license for each clustered ESX(i). This ensures the uninterrupted operation of your backup 
plans when virtual machines are moved around the cluster. 

If you have n ESX(i) servers, it is recommended that you purchase n Virtual Edition licenses and 
import them to the license server or to the management server before the first backup. If you are 
planning to add more virtualization servers to your environment, upload a few more licenses in 
advance. 
 

2.4.1 Importing Agent for ESX(i) (Virtual Appliance) 
Use this method for troubleshooting purposes or if you cannot install Acronis Backup & Recovery 
11.5 Management Server for some reason. In all other cases, please follow the instructions provided 
in the previous section. 
 

2.4.1.1 Step 1: Extracting the OVF template 
1. On a machine running Windows, start the Acronis Backup & Recovery 11.5 setup program. 
2. Click Extract installation files. Then, in the list of installation packages, select the Agent for ESX(i) 

Virtual Appliance (AcronisVirtualAppliance.msi) check box. 
Tip: Alternatively, you can click Install Acronis Backup & Recovery 11.5, select the I want to 
manually select the Acronis components... check box, and then select the Agent for ESX(i) 
(Virtual Appliance) check box in the list of components. Complete the installation and skip steps 
3 and 4. 

3. In Extract to, specify the folder to which you want to extract the virtual appliance's installation 
package, and then click Extract. 

4. Run the installation package. 

After the installation is complete, the virtual appliance's files will be located in the folder 
%ProgramFiles%\Acronis\ESXAppliance. Share this folder for read, if you run the vSphere Client on a 
different machine. 
 

2.4.1.2 Step 2: Deploying the OVF template 
1. Start the vSphere Client and log on to the ESX(i) server. 
2. On the File menu, point to Deploy OVF Template. Follow the Deploy OVF Template wizard.  

Tip. In VMware Infrastructure, point to Virtual Appliance, and then click Import. Follow the 
Import Virtual Appliance wizard. 

3. In Source, select Deploy from File, and then specify the path to the virtual appliance's OVF 
package—normally: %ProgramFiles%\Acronis\ESXAppliance. 

4. Review the OVF Template Details and click Next. 
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5. In Name and Location, type the name for the appliance or leave the default name 

AcronisESXAppliance. 
6. In Network mapping, select the bridged mode for the network adapter. 
7. In Datastore, leave the default datastore unless it does not have enough space for the virtual 

appliance. In this case, select another datastore. Skip this step if there is only one datastore on 
the server. 

8. Review the summary and then click Finish. After the successful deployment is reported, close the 
progress window. 

 

2.4.1.3 Step 3: Configuring the virtual appliance 
1. Starting the virtual appliance  

In the vSphere Client, display the Inventory, right-click the virtual appliance's name, and then 
select Power > Power On. 
Select the Console tab. The virtual appliance welcome screen tells you what to do next. Click 
Close. You will be able to access this screen at any time by clicking the help button in the virtual 
appliance GUI. 
You are taken to the Acronis Backup & Recovery 11.5 Agent for VMware vSphere ESX(i) screen 
where you continue the agent configuration. 

2. Time zone 
Under Virtual machine, in Time zone, click Change and select the time zone for the location 
where the management console is installed. 
An ESX(i) server always works in the GMT time zone. When being imported, a virtual appliance 
inherits the GMT time zone from the server. If the console works in another time zone, you need 
to synchronize the virtual appliance with the console to ensure that the tasks scheduled with the 
console run at the appropriate time. 

3. vCenter/ESX(i) 
Under Agent options, in vCenter/ESX(i), click Change and specify the vCenter Server name or IP 
address. The agent will be able to back up and recover any virtual machine managed by the 
vCenter Server.  
If you do not use a vCenter Server, specify name or IP address of the ESX(i) host whose virtual 
machines you want to back up and recover. Normally, backups run faster when the agent backs 
up virtual machines hosted on its own host.  
Specify the credentials that the agent will use to connect to the vCenter Server or ESX(i). We 
recommend that the account have the necessary privileges for backup and recovery on the 
vCenter Server or ESX(i). You can click Check connection to ensure the access credentials are 
correct. 

The virtual appliance is ready to work. In addition, you can change the following settings: 

 Network settings 
The agent's network connection is configured automatically by using Dynamic Host Configuration 
Protocol (DHCP). To change the default configuration, under Agent options, in eth0, click Change 
and specify the desired network settings. 

 Local storages 
You can attach an additional disk to the virtual appliance so the Agent for ESX(i) can back up to 
this locally attached storage. Such backup is normally faster than a backup via LAN and it does 
not consume the network bandwidth.  
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The virtual disk size must be at least 10 GB. Add the disk by editing the settings of the virtual 
machine and click Refresh. The Create storage link becomes available. Click this link, select the 
disk and specify a label for it. 
Be careful when adding an already existing disk. Once the storage is created, all data previously contained 
on this disk will be lost. 

 

2.4.1.4 Step 4: Adding the virtual appliance to the management server 
The minimum set of components that enables backing up virtual machines from a host includes the 
management console, the license server and the agent. With this set, you can back up and recover 
virtual machines using the direct console-agent connection. 

However, Acronis highly recommends that you install and use Acronis Backup & Recovery 11.5 
Management Server, even if you have only one ESX(i) host. The management server lets you easily 
deploy and update agents, set up and monitor backups of your virtual machines. If, for better 
performance, you configure several agents to manage the same host, the management server will 
automatically distribute virtual machines between the agents. This is necessary to equalize the 
agents' load and to avoid a conflict of snapshots which may occur if two agents try to back up a 
virtual machine simultaneously.  

If you are planning to use the management server, register the virtual appliance on the server. 

To add the virtual appliance to the management server 
1. Start Acronis Backup & Recovery 11.5 Management Console. 
2. Connect the management console to the virtual appliance using the IP address displayed in the 

virtual appliance console. 
3. Select Options > Machine options > Machine management from the top menu. 
4. Select Centralized management and specify the management server IP/name. Click OK. 
5. Specify the user name and password for the management server administrator's account. Click 

OK. 

Alternatively, you can add the appliance to the management server on the server's side.  
 

2.4.2 Updating Agent for ESX(i) (Virtual Appliance) 
Update from the management server 
This update method applies only to those virtual appliances that are registered on the management 
server. This method is preferable to the manual procedure described later in this section, because all 
configuration settings (local backup plans, centralized backup plans and group membership) related 
to the virtual machines managed by the agent will be preserved in this case. 

Prerequisites 

Acronis Backup & Recovery 11.5 Management Server uses TCP ports 443, 902, and 9876 for 
operations with Agent for ESX(i) (Virtual Appliance). Make sure that the management server can 
access the vCenter Server and the ESX(i) hosts through these ports: 

 If the management server uses a custom firewall, make sure that this firewall does not block 
outgoing connections through these ports. Windows Firewall is configured automatically by 
Acronis Backup & Recovery 11.5. 
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 If the traffic from the management server goes through a router or a similar network device, 

make sure that the device does not block this traffic. 

No special configuration is required on the vCenter Server or the ESX(i) hosts themselves. 

To update the virtual appliances from the management server 
1. Update the management console and the management server. 
2. Connect the console to the management server. 
3. In the Navigation tree, right-click the group that has the same name as the vCenter Server. If 

VMware vCenter integration is not enabled, right-click Virtual machines.  
4. Click Update Agent for ESX(i).  
5. Select the agents that you want to update. Agents that are already of the latest version are 

unavailable for selection. 
6. Click Update Agent for ESX(i). 

The virtual appliances will be updated; the agents' configuration settings will be preserved. 

Manual update  
Manual update of the virtual appliance involves installing a new appliance and deleting the old one. 
Use this method only if updating from the management server is not possible for some reason. 

After manually updating the virtual appliance, you will have to re-create local backup plans that 
existed on the appliance. 

To update the virtual appliance (VA) manually 
1. Install and configure the new VA, as described in "Importing Agent for ESX(i) (Virtual Appliance)" 

(p. 54). 
2. Delete (p. 67) the old virtual appliance from the ESX(i) server. 
3. [Optional] Re-create local backup plans that previously existed on the VA if you want to continue 

using them. 
4. [Optional] Re-establish the machines' membership in dynamic groups that use the All VMs 

backed up by agent criterion. To do this, specify the updated VA as a criterion for the group. 
Details. The machines' membership in such dynamic groups is lost because the old VA is removed 
from the management server during update. 

You do not need to re-add either static or dynamic custom groups to the centralized backup plans. As 
soon as the machines' membership in the groups is re-established, the appropriate backup plans will 
continue protecting the machines. 
 

2.5 Installation of Agent for Hyper-V 
Agent for Hyper-V enables you to back up and recover virtual machines from a Hyper-V host without 
installing agents on the virtual machines. 

Preparation 
Licenses. Ensure that you have a sufficient number of licenses for Virtual Edition. You need one 
license per Hyper-V host. If you have a Hyper-V cluster (also called a failover cluster), we recommend 
obtaining licenses for each node of the cluster. To use the product in the trial mode, you do not need 
licenses. 
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Management server. We recommend installing Acronis Backup & Recovery 11.5 Management Server 
and importing the licenses. If you have a Hyper-V cluster, installing the management server will 
enable you to back up clustered virtual machines whatever node they are running on. 

Installation 
Install the agent on the Hyper-V host. In a Hyper-V cluster, install the agent on each node of the 
cluster. 

 In Windows Server 2008/2008 R2 or Windows Server 2012/2012 R2, you can install the agent 
from the setup program (p. 20). Select the Back up this machine's data check box and follow the 
on-screen instructions. 

 In Microsoft Hyper-V Server 2008/2008 R2 or Microsoft Hyper-V Server 2012, you can install the 
agent remotely (p. 47). 

If prompted for the Acronis Managed Machine Service (agent) account, specify an account of a 
domain user who has administrative privileges on all nodes of your Hyper-V cluster. With this 
account the agent will be able to access virtual machines on any of the nodes. Alternatively, you can 
choose to create a new account for the agent. Then, when creating centralized backup plans or 
recovery tasks, you will need to specify credentials for the domain account with the necessary 
privileges. 

If you installed the management server, choose to register the agent on it during installation. 
 

2.6 Installation for other virtualization platforms 
Unlike ESX and Hyper-V, the following virtualization platforms require that an agent is installed on a 
virtual machine: 

 Citrix XenServer 
 Red Hat Enterprise Virtualization (RHEV) 
 Kernel-based Virtual Machines (KVM) 
 Oracle VM Server, Oracle VM VirtualBox 
 Parallels Server Bare Metal 

For the complete list of supported virtualization platforms, refer to "Supported virtualization 
platforms" in the "Backing up virtual machines" document. 

For information about the required licenses, refer to "Licensing for virtual machines" (p. 12). 

If you need to back up the virtual machines 
Install Acronis Backup & Recovery 11.5 Agent for Windows or Acronis Backup & Recovery 11.5 Agent 
for Linux on every virtual machine you want to back up. For step-by-step instructions, refer to 
"Installation in Windows" (p. 18), "Installation in Linux" (p. 40), or "Remote installation" (p. 47). 

If you use Red Hat Enterprise Virtualization, be sure to familiarize yourself with the "Backup and 
recovery of RHEV virtual machines" section of the "Backing up virtual machines" document. This 
document contains step-by-step instructions on installing the agents and adding the machines to the 
management server. 

The backup and recovery operations are the same as with a physical machine. You can also use 
bootable media to do "cold" backups and "bare metal" recovery to an empty virtual machine. 
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If you need to back up the virtualization host 
Acronis Backup & Recovery 11.5 enables you to back up the physical host by using the same license 
as for the hosted virtual machines.  

If the host is running an operating system supported by Agent for Windows or Agent for Linux (see 
"Supported operating systems" (p. 13)), you can install the corresponding agent on the host. You can 
also use bootable media to do "cold" backups and "bare metal" recovery. 

If the host is not running a supported operating system, you have only one option: a sector-by-sector 
backup by using bootable media. While recovery from such a backup is possible, Acronis cannot 
guarantee that the system boots and will be fully operational. 
 

2.7 Installation of Agent for Exchange 
Agent for Exchange enables data protection of Microsoft Exchange servers. 

Preparation 
Licenses. Ensure that you have a sufficient number of licenses. You need one license per Exchange 
server. If you have an Exchange cluster, we recommend obtaining licenses for each node of the 
cluster. Agent for Exchange requires either of the following licenses to work:  

 Acronis Backup & Recovery 11.5 for Microsoft Exchange Server. 
 Acronis Backup & Recovery 11.5 Advanced Server SBS Edition. 

To use the product in the trial mode, you do not need licenses. 

Requirements. Ensure that the Exchange server meets the following requirements: 

 For Microsoft Exchange Server 2013: Cumulative Update 1 (CU1) or later must be installed. 
 For Microsoft Exchange Server 2007/2010: The MAPI Client and Collaboration Data Objects 

(version 1.2.1) package must be installed. To download and install this package, visit 
http://www.microsoft.com/en-us/download/details.aspx?id=36771. 

 For Microsoft Exchange Server 2003 SP2: Hotfix http://support.microsoft.com/kb/908072 must 
be installed. 

 The Exchange writer for VSS must be turned on. In Windows Small Business Server 2003, the 
writer is turned off by default. For instructions on how to turn it on, see the following Microsoft 
Knowledge Base article http://support.microsoft.com/kb/838183/. 

Which setup program to choose? 
Agent for Exchange is included in the setup programs of both the stand-alone and advanced editions 
of Acronis Backup & Recovery 11.5. The functionality provided by the agent is the same in both setup 
programs. However, certain advanced features can be used only in combination with components of 
the advanced Acronis Backup & Recovery 11.5 editions. Here are some tips to help you choose 
between a stand-alone and an advanced configuration. 

 Setup program for stand-alone editions of Acronis Backup & Recovery 11.5 
Recommended for backing up Exchange data in simple Exchange organizations having a 
stand-alone Exchange server that hosts all Exchange services and data. 

 Setup program for the advanced editions of Acronis Backup & Recovery 11.5 
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Recommended for large Exchange organizations where multiple Exchange servers are integrated 
into a cluster. The following features can be used only in advanced Acronis Backup & Recovery 
11.5 configurations: 
 Comprehensive protection of Exchange clusters  

Requires installation of Acronis Backup & Recovery 11.5 Management Server and installation 
of Agent for Exchange on each cluster node. 

 Using the Express full backup method 
Requires installation of Acronis Backup & Recovery 11.5 Management Server and Acronis 
Backup & Recovery 11.5 Storage Node. Requires installation of the "Deduplication for 
Microsoft Exchange Server" add-on to Agent for Exchange.  
The add-on is purchased separately. You do not need to purchase and install this add-on if 
Agent for Windows and its deduplication add-on are already installed on your Exchange 
server.  

Installation from the setup program for stand-alone editions 
Run the setup program and follow the on-screen instructions. 

Installation from the setup program for advanced editions 
Remote installation of Agent for Exchange is not possible, because the agent setup has certain requirements 
that can be checked in the local interactive installation mode only. 

Installing the agent on an Exchange server 
1. Run the setup program. 
2. Proceed to the window where you are asked how you want to use this machine and select the 

Back up this machine's data check box. 
3. Follow the on-screen instructions (p. 20). If you installed the management server, choose to 

register Agent for Exchange on it during installation. 

Installing agents on Exchange cluster nodes 

To back up data in an Exchange cluster, install the agent on each node of the cluster. When installing 
the agent on a cluster node, specify an existing account of a domain user for the agent service. With 
this account, the agent will be able to access the clustered data on any of the nodes. The account 
must have administrative privileges on each of the cluster nodes. 

To install the agent on a cluster node 
1. Run the setup program.  
2. Proceed to the window where you are asked how you want to use this machine and select the I 

want to manually select the Acronis components and customize the installation process check 
box. 

3. In the components tree, select Agent for Exchange. 
4. Follow the on-screen instructions. 

Details. When prompted to assign logon accounts to the Acronis services, in Acronis Managed 
Machine Service (agent), select Use an existing account and specify the account that has 
administrative privileges on each of the cluster nodes. Alternatively, you can choose to create a 
new account for the agent. Then, when creating centralized backup plans or recovery tasks, you 
will need to specify credentials for the domain account that has the necessary privileges. 
If you installed the management server, choose to register Agent for Exchange on it during 
installation. 
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2.8 Installation of Agent for SQL (single-pass) 
Agent for SQL (single-pass) enables you to create single-pass disk and application backups and to 
recover Microsoft SQL databases from them. 

The agent can only be installed on a machine running Microsoft SQL Server. Remote installation of 
the agent is not possible. 

Agent for SQL (single-pass) is installed as an add-on to Agent for Windows.  

Licenses required 
To install Agent for Windows, use any license that enables installation of this agent. 

If Agent for Windows is installed by using the Advanced Server SBS Edition license, you can install 
Agent for SQL (single-pass) without an additional license. Otherwise, use one of the following 
licenses: 

 Acronis Backup & Recovery 11.5 Microsoft SQL Server Add-On 
 Acronis Backup & Recovery 11.5 Microsoft SharePoint Add-On 

Each of these licenses enables you to install Agent for SQL (single-pass) onto a physical host and onto 
four virtual machines running on the same host. Please remember that Agent for Windows must be 
installed on each virtual machine along with Agent for SQL (single-pass). 

To use the product in the trial mode, you do not need licenses. 

Installation 
Install the agent in the same way as Agent for Windows. For detailed step-by-step instructions, refer 
to "Interactive installation in advanced editions" (p. 20). 

Credentials for Microsoft SQL instances 

During the installation, you are asked to specify the sysadmin credentials for each Microsoft SQL 
instance installed on the machine. These credentials are required to grant the sysadmin role to the 
agent service account.  

You can skip entering the credentials and grant the agent the sysadmin role later by using SQL Server 
Management Studio or by running a T-SQL script. If you do not want to grant the sysadmin role to 
the agent, you will need to specify the sysadmin credentials in every backup plan. 

For details, see the "Permissions for SQL Server backup and recovery" section of the User Guide. 
 

2.9 Installation of Agent for Active Directory 
(single-pass) 

Agent for Active Directory (single-pass) enables you to create single-pass disk and application 
backups and to recover Microsoft Active Directory data from them. 

The agent can only be installed on a domain controller. Remote installation of the agent is not 
possible. 

Agent for Active Directory (single-pass) is installed as an add-on to Agent for Windows.  
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Licenses required 
To install Agent for Windows, use any license that enables installation of this agent. 

If Agent for Windows is installed by using the Advanced Server SBS Edition license, you can install 
Agent for Active Directory (single-pass) without an additional license. Otherwise, use the following 
license: Acronis Backup & Recovery 11.5 Microsoft Active Directory Add-On. 

This license enables you to install Agent for Active Directory (single-pass) onto a physical host and 
onto four virtual machines running on the same host. Please remember that Agent for Windows 
must be installed on each virtual machine along with Agent for Active Directory (single-pass). 

To use the product in the trial mode, you do not need licenses. 

Installation 
Install the agent in the same way as Agent for Windows. For detailed step-by-step instructions, refer 
to "Interactive installation in advanced editions" (p. 20). 
 

3 Upgrading from a stand-alone product to the 
advanced platform 

Purchasing licenses 
Prior to upgrade, purchase the advanced platform licenses for each machine where you are planning 
to upgrade Acronis Backup & Recovery 11.5. Names of the licenses depend on the stand-alone 
product installed on the machine. 

Installed product Licenses suitable for upgrade 

Server for Windows  
(on any Windows edition) 

Advanced Server for Windows 

[Optional] Universal Restore for Advanced Server for Windows * 

[Optional] Deduplication for Advanced Server for Windows ** 

Server for Windows 
(on Windows SBS, 
Windows Server 2012 
Essentials/Foundation, or 
Windows Server 2012 R2 
Essentials) 

Advanced Server SBS Edition 

Universal Restore comes free with this edition 

[Optional] Deduplication for Advanced Server SBS Edition** 

Server for Linux 

Advanced Server for Linux 

[Optional] Universal Restore for Advanced Server for Linux * 

[Optional] Deduplication for Advanced Server for Linux ** 

Workstation 

Advanced Workstation 

[Optional] Universal Restore for Advanced Workstation * 

[Optional] Deduplication for Advanced Workstation ** 

* The license is required if you want to use or continue using Acronis Universal Restore (p. 6). 

** The license is required if you want to use Acronis Deduplication (p. 6). 

After the purchase, you will receive an e-mail with the license keys. 
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Upgrading the product 
To upgrade Acronis Backup & Recovery 11.5 from a stand-alone product to the advanced platform, 
do the following: 

Step 1. Changing licenses 

On each machine where you want to upgrade Acronis Backup & Recovery 11.5, change a license as 
follows: 

1. Run Acronis Backup & Recovery 11.5. 
2. On the Help menu, click Change license. 
3. Click Change to the right of License for backup of disks/files, click Change, and then click Use the 

following license keys. 
4. Enter the new license keys for this machine. 
5. Click OK to apply the new licenses, click Yes in the warning message, and then click OK. 

The licenses previously assigned to the machine will be revoked and the management console will 
restart. Now, you can connect the console to a remote machine and connect to this machine from a 
remote location. 

Step 2. Downloading the setup program 

Download the setup program for the advanced platform from the Acronis website as described at 
http://kb.acronis.com/content/1642. 

Step 3. Installing the management server 

Install Acronis Backup & Recovery 11.5 Management Server on a machine running Windows. The 
machine must have at least 8 GB of RAM and 4.5 GB of free space on a system disk.  

It is acceptable to install the management server on one of the machines where you have upgraded 
the product. To do this: 

1. Run the setup program, and then click Install Acronis Backup & Recovery 11.5. 
2. After accepting the terms of the license agreement, click Modify. 
3. In the components tree, select Management Server. 
4. Follow the on-screen instructions. In most cases, you can leave the default settings. 

In large environments, we recommend setting up a dedicated physical or virtual server. For detailed 
information, refer to the installation documentation for advanced editions (p. 20). 

Step 4. Adding the upgraded machines to the management server 
1. On any machine where the product was upgraded, run Acronis Backup & Recovery 11.5. 
2. Click Connect to a management server and type the server name or IP address. If prompted for 

credentials, specify the user name and password of a user who is a member of the Acronis 
Centralized Admins and Acronis Remote Users groups on the management server. 

3. In the Navigation tree, select  Machines with agents. 

4. Click  Add multiple machines on the toolbar. 
5. Add the upgraded machines in any of the following ways: 
 By specifying their names or IP addresses. 
 By browsing the network. 
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 By browsing an Active Directory domain. 
 By importing a list of machines from a .txt or .csv file. 
For detailed information, refer to the "Specifying the list of machines" (p. 49) section of the 
installation documentation for advanced editions. 

Tips for further usage 
The added machines will appear in the Machines with agents view of the management server.  

The backup plans on the machines will remain intact. To view them on the management server, 
right-click the machine name > View details > Backup plans and tasks. The product continues doing 
backups and you can recover from the backups created before the upgrade. 

You can now create centralized backup plans that will simultaneously back up several machines to a 
single location. 
 

4 Checking for software updates 
Each time you start the management console, Acronis Backup & Recovery 11.5 checks whether a 
new version of the software is available on the Acronis Web site. If so, the software provides a link 
for downloading a setup program of the new version. 

To check for updates manually, start the management console and then click Help > Check for 
updates. In that window, you can also disable the automatic checks for updates. 

Another way to enable or disable the automatic checks for updates is to configure Acronis 
Administrative Template. In this case, the parameter value set in the administrative template will 
supersede the setting in the Check for updates window. For more details, see "Parameters set 
through administrative template" in the product Help or the User Guide. 

For information about updating Acronis Backup & Recovery 11.5, see the "Update" section (p. 29) 
(for local installation in Windows) or the corresponding installation section (for other ways of 
installation). 
 

5 Uninstalling Acronis Backup & Recovery 11.5 
This section describes uninstallation of Acronis Backup & Recovery 11.5. 
 

5.1 Uninstalling advanced editions of Acronis Backup & 
Recovery 11.5 

When you uninstall a component that uses a license on Acronis License Server, the license remains 
assigned to the machine. If you want to use this license for a different machine, revoke the license 
manually. 
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5.1.1 Uninstallation in Windows 

5.1.1.1 Interactive uninstallation 
To uninstall Acronis Backup & Recovery 11.5 or its components, we recommend using the following 
procedures instead of the Add or Remove Programs or Programs and Features tool of Windows. 

To uninstall all components of Acronis Backup & Recovery 11.5 
1. Click Start -> All Programs -> Acronis -> Uninstall Acronis Backup & Recovery 11.5. 
2. To delete associated information (see later in this topic), select the Remove the product's log, 

tasks, vaults and configuration settings check box. 
3. Click Remove. 
To uninstall individual components or features of Acronis Backup & Recovery 11.5 
1. Start the Acronis Backup & Recovery 11.5 setup program. 
2. Click Install Acronis Backup & Recovery 11.5. 
3. Click Modify. 
4. Clear the check boxes next to the names of the components or features that you want to 

uninstall. 
5. To delete associated information (see later in this section), select the Remove the product's log, 

tasks, vaults and configuration settings check box. 

Deleting associated information 
If you are planning to reinstall a component at a later time, you may want to keep its associated 
information. 

If instead you want to delete this information, select the Remove the product's log, tasks, vaults and 
configuration settings check box. As a result, the following information will be deleted: 

 When uninstalling Acronis Backup & Recovery 11.5 Agent for Windows: the log and tasks of the 
agent 

 When uninstalling Acronis Backup & Recovery 11.5 Management Server: the management server 
databases, which store the configuration of centralized backup plans, the operation log, and 
statistics 

 When uninstalling Acronis Backup & Recovery 11.5 Storage Node: the log and tasks of the 
storage node 

 

5.1.1.2 Unattended uninstallation 
To uninstall a component or feature of Acronis Backup & Recovery 11.5 in the unattended mode, you 
need to run the msiexec utility. This utility uses the corresponding installation package (an .msi file). 

To uninstall a component or feature 
1. Extract the corresponding installation package to a folder or a network share. 
2. Run the following command (here, the installation package is assumed to be 

AcronisAgentWindows.msi, saved in the \\myserver\share network share): 
msiexec /uninstall \\myserver\share\AcronisAgentWindows.msi /qb 
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Uninstalling an agent 
When you uninstall an agent, we recommend first uninstalling its features, then the agent itself and 
then the Acronis Backup & Recovery 11.5 Agent Core component. 

For example, if the agent is installed with the Universal Restore feature, run uninstallation 
commands in the following order: 

msiexec /uninstall \\myserver\share\AcronisUniversalRestore.msi /qb 
msiexec /uninstall \\myserver\share\AcronisAgentWindows.msi /qb 
msiexec /uninstall \\myserver\share\AcronisAgentCore.msi /qb 

Uninstalling the license server 
If you need to uninstall the Acronis License Server, you should do so after uninstalling all agents that 
use it. Also keep in mind that the license server may be used by other Acronis products. 

The license server is integrated with the management server. To uninstall the management server, 
run the following command (change the path if needed): 

msiexec /uninstall \\myserver\share\AcronisManagementServer.msi /qb 

To uninstall the license server installed as a separate component, run the following command 
(change the path if needed): 

msiexec /uninstall \\myserver\share\AcronisLicenseServer.msi /qb 
 

5.1.1.3 Remote uninstallation 
The remote uninstallation is performed by using the remote_uninstaller.exe utility. It allows 
you to uninstall all Acronis Backup & Recovery 11.5 components from the specified machines running 
Windows. The logs, tasks, vaults, and configuration settings on the machines remain intact. 

The utility is available on any Windows machine where Acronis Backup & Recovery 11.5 
Management Console or Acronis Backup & Recovery 11.5 Management Server is installed. The path 
to the utility is as follows: 

 In a 32-bit version of Windows: 
%CommonProgramFiles%\Acronis\BackupAndRecovery\Common 

 In a 64-bit version of Windows: 
%CommonProgramFiles(x86)%\Acronis\BackupAndRecovery\Common 

Preparation 
Preparatory steps on each of the machines are the same as for remote installation (p. 48). 

Running the utility 
In the command line, type the full path to the utility and the full path to a text file with the list of 
required machines.  

Each line of the specified file must contain information about one machine in the following format: 

<machine IP address or hostname>;<user name>;<password> 

Example 
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"%CommonProgramFiles%\Acronis\BackupAndRecovery\Common\remote_uninstaller.exe" 
C:\machines_list.txt 

where the file machines_list.txt contains the following lines: 

10.200.200.10;usr5;123456 
10.200.200.15;admin25;"654 321" 

When you run the utility, it shows whether the uninstallation process has started successfully on 
each machine. The utility does not report whether the uninstallation has been successful or not. 
 

5.1.2 Uninstallation in Linux 
To uninstall all components of Acronis Backup & Recovery 11.5 

Do the following as the root user: 

1. Run the following commands to uninstall Acronis Backup & Recovery 11.5 components: 
# /usr/lib/Acronis/BackupAndRecovery/uninstall/uninstall 
# /usr/lib/Acronis/BootableComponents/uninstall/uninstall 
# /usr/lib/Acronis/BackupAndRecoveryConsole/uninstall/uninstall 

2. Run the following command to delete the source files of the SnapAPI module: 
# rm -rf /usr/src/snapapi* 

To uninstall all components in the unattended mode, run each of the ./uninstall commands with the 
-a parameter. 
 

5.2 Deleting ESX(i) Virtual Appliance 
Acronis Backup & Recovery 11.5 Management Server provides an easy way to remove Agent for ESX(i) from ESX 
or ESXi servers. You might generally prefer that method to the procedure described later in this section. 
Connect the console to the management server. In the Navigation tree, right-click Virtual machines, then click 
Remove Agent for ESX(i). Refer to the context help for further instructions. 

You may need to manually delete the Agent for ESX(i) (Virtual Appliance), or VA, in the following 
cases: 

 The VA is not registered on the management server. 
 You are not using vCenter Server or integration with vCenter Server is not enabled. 
 The VA is corrupted. 
To remove Agent for ESX(i) (Virtual Appliance) manually 
1. Start VMware vSphere Client and log on to the ESX(i) host or to vCenter Server. 
2. Power off the VA. 
3. If the VA uses a locally attached storage on a virtual disk, and you want to preserve data on that 

disk, do the following: 
a. Right-click the VA, and then click Edit Settings. 
b. Select the disk with the storage, and then click Remove. Under Removal Options, click 

Remove from virtual machine. 
c. Click OK. 
As a result, the disk remains in the datastore. You can attach the disk to another VA. 

4. Right-click the VA, and then click Delete from Disk. 
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5. Remove the VA from the management server. Skip this step if the appliance is not registered on 

the management server or has been already removed. 
To remove the VA, connect to the management server, right-click the VA in the All physical 
machines list, and then click Delete machine from AMS. 

 

5.3 Deleting Acronis Secure Zone 
Uninstallation of Acronis Backup & Recovery 11.5 does not affect Acronis Secure Zone and its 
contents. You will still be able to recover data from Acronis Secure Zone on booting from bootable 
media. 

If you need to delete Acronis Secure Zone, perform the following steps in the operating system 
(before the agent uninstallation) or under bootable media. 

To delete Acronis Secure Zone 
1. On the Actions menu, click Manage Acronis Secure Zone. 
2. In the Delete Acronis Secure Zone window, select volumes to which you want to add the space 

freed from the zone and then click OK. 
If you select several volumes, the space will be distributed proportionally to each partition. If you 
do not select any volume, the freed space becomes unallocated. 

After you click OK, Acronis Backup & Recovery 11.5 will start deleting the zone. 
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